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Introduction

New Features in Pro Tools 9.0

This chapter provides an overview of new fea-
tures in Pro Tools® 9.0 for Pro Tools,

Pro Tools|HD, and Pro Tools|HD Native systems
on qualified versions of Mac OS X and Win-
dows.

What'’s New for all Pro Tools 9.0
Users

Pro Tools 9.0 provides a single, unified installer
for all versions of Pro Tools:

If you install Pro Tools 9.0 on your Pro Tools|HD
or Pro Tools|HD Native system, launching

Pro Tools 9.0 will run Pro Tools HD software (if
a valid Pro Tools HD authorization is detected
on a connected iLok and Pro Tools|HD or

Pro Tools|HD Native hardware is present).

If you install Pro Tools on a system with any
other hardware, launching Pro Tools 9.0 will
run Pro Tools software (if a valid Pro Tools au-
thorization is detected on a connected iLok).

Pro Tools Features and Enhancements

The following features and enhancements are
new to Pro Tools and Pro Tools HD:

Single, Unified Version of Pro Tools
¢ Pro Tools 9.0 provides a single, unified in-
staller for Pro Tools and Pro Tools HD

e New Pro Tools 9.0 PACE copy protection with
iLok USB key

Pro Tools Audio Engine

e Support for Core Audio hardware (including
Mac built-in audio) with supported Core Au-
dio drivers installed

e Support for ASIO hardware with supported
ASIO drivers installed
e New Pro Tools Playback Engine settings

e Current Engine setting for selecting which
audio engine to use

e Pro Tools Aggregate I/O option for using
the built in audio on Mac

e Delay Compensation settings for all ver-
sions of Pro Tools
e New Pro Tools Hardware settings

e Ability to select Core Audio and ASIO inter-
faces

e Launch Setup Application command for
Core Audio and ASIO audio interfaces

Chapter 1: Introduction



Mixing and Recording
¢ Increased number of audio and MIDI tracks
¢ Increased number of internal mix busses

e New Track and Send Output selector com-
mands for faster, simplified signal routing and
mixer configuration

e Multiple Stereo Pan Depth options

e 7.1 and 7.0 standard HD surround formats
(Pro Tools HD and Pro Tools with Complete
Production Toolkit 2 only)

e Support for EUCON™ for controlling
Pro Tools with EUCON-aware control surfaces

Import and Export Options for All Pro Tools
Systems

e Advanced Import Session Data (formerly
Pro Tools HD only, or Pro Tools LE with
DV Toolkit 2 or Complete Production Toolkit
only)

e Import AAF and OMF sequences (formerly
with the DigiTranslator 2.0 option only)

e New AAF import features and enhancements:
e Ability to import stereo AAF audio tracks

e Ability to import RTAS plug-in data from
AAF sequences

* New Locators To Import setting for import-
ing locators from Media Composer-gener-
ated AAF sequences

e Export AAF and OMF sequences (formerly
with the DigiTranslator 2.0 option only)

¢ Avid Interplay Support with Mac

¢ Ability to check data into and out of Avid In-
terplay directly with the Interplay Access
browser

e Export MP3 (formerly with the MP3 Export
option only)

e Export Session as Text (formerly Pro Tools HD
only)

What’s New in Pro Tools 9.0

What’s New for Pro Tools LE and
Pro Tools M-Powered Users

With Pro Tools 9.0, Pro Tools is now a single,
unified application. Pro Tools LE and Pro Tools
M-Powered will no longer be developed.

Pro Tools 9.0 effectively replaces all lower ver-
sions of Pro Tools LE and Pro Tools M-Powered
software. The following features and enhance-
ments are new to Pro Tools for former Pro Tools
LE and M-Powered users.

Q These features have been available in lower
" wversions of Pro Tools for Pro Tools HD us-

ers. Subsets of these features have been
available in lower versions of Pro Tools in
various combinations for Pro Tools LE users
with DV Toolkit 2 or Complete Production
Toolkit, or for Pro Tools LE and Pro Tools
M-Powered users with Music Production
Toolkit 2.

1/0 Setup Improvements

¢ Session and System settings

e Output and internal mix busses

¢ Ability to Import I/O Settings by page

e Overlapping Paths

e Improved session interchange

Advanced DigiBase Features
¢ Advanced search features

e DigiBase Catalogs

Editing Features

¢ Auto-Scrolling tracks in the Mix and Edit win-
dows

e Advanced Beat Detective features
e Separate multiple tracks

e Collection mode



Delay Compensation

¢ Delay Compensation option

¢ Delay Compensation Engine

¢ Delay Compensation view

¢ Low Latency Monitoring During Recording

¢ Delay Compensation on Auxiliary Input
tracks

¢ Delay Compensation for MIDI
e H/W Insert Delay (Compensation)

Time Code and Synchronization Features

e Timebase Rulers
¢ Time Code Ruler
¢ Secondary Time Code Ruler

¢ Feet+Frames
¢ Ability to set Time Code and Feet+Frame rates
¢ Ability to redefine Time Code Position

e Ability to redefine Current Feet+Frames Posi-
tion

e Use Subframes option for Go To command

e Pull Up and Pull Down commands
e Audio Rate Pull Up/Down
e Video Rate Pull Up/Down

PRE Support

* Mic Pre Peripherals
e Mic Pre I/O Setup
* Mic PRE view

* Mic Preamp window

Plug-in and Software Options

e Complete Production Toolkit 2

System Requirements and
Compatibility

Pro Tools can be used with an Avid-qualified
Mac or Windows computer.

A DVD drive is required to use the Pro Tools In-
staller disc.

Avid can only assure compatibility and provide
support for hardware and software it has tested
and approved.

For complete system requirements and a list of
qualified computers, operating systems, hard
drives, and third-party devices, refer to the latest
information on our website:

www.avid.com

Chapter 1: Introduction

3



4 What’s New in Pro Tools 9.0



Pro Tools Application and System Changes

Unified Pro Tools Installer

Pro Tools 9.0 provides a single, unified installer
for Pro Tools and Pro Tools HD. Pro Tools 9.0 is
supported on the following types of systems:

Pro Tools HD

These systems include Pro Tools HD software
with Pro Tools|HD or Pro Tools|HD Native hard-
ware.

Pro Tools

These systems include Pro Tools software with
003® or Digi 002™ family audio interfaces,
Eleven® Rack, Mbox®, and Mbox 2 family audio
interfaces, or M-Audio hardware.

A\ The original Mbox hardware is not supported
with Pro Tools 8.0.3 and higher.

A\ Pro Tools LE and Pro Tools M-Powered soft-
ware will no longer be developed. Pro Tools
9.0 effectively replaces all lower versions of
Pro Tools LE and Pro Tools M-Powered soft-
ware.

Q You can upgrade from lower versions of
Pro Tools LE and Pro Tools M-Powered to
Pro Tools 9.0 for use with your Pro Tools LE
or M-Audio hardware.

Pro Tools Core Audio/ASIO

Pro Tools Core Audio/ASIO systems include

Pro Tools 9.0 software with third-party audio in-
terfaces with compatible Core Audio (Mac) or
ASIO (Windows) drivers, including the built-in
audio available on Mac computers (Core Audio).

A\ For alist of qualified audio interfaces
and computers, refer to our website:
www.avid.com/compatibility.

Authorizing Pro Tools

Pro Tools 9.0 software is authorized using the
iLok USB Smart Key (iLok) from PACE Anti-Pi-
racy.

iLok USB key

Q You can use either the new version of the
iLok (shown above) or the previous version
of the iLok to hold your Pro Tools authori-
zations.
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An iLok can hold hundreds of authorizations for
all of your iLok-enabled software. Once an iLok
is authorized for a given piece of software, you
can use the iLok to authorize that software on
any computer.

Pro Tools HD Authorization

A Pro Tools HD 9.0 authorization lets you run
Pro Tools HD 9.0 on a supported Mac or Win-
dows computer with Pro Tools|HD or

Pro Tools|HD Native hardware. A Pro Tools HD
9.0 authorization also authorizes Pro Tools with
Complete Production Toolkit 2 functionality on
supported Mac or Windows systems without
Pro Tools|HD or Pro Tools|HD Native hardware.

Pro Tools 9.0 Authorization

A Pro Tools 9.0 authorization lets you run

Pro Tools 9.0 on a supported Mac or Windows
computer with a Pro Tools or M-Audio interface,
or any third-party audio interface with sup-
ported Core Audio (Mac) or ASIO (Windows) de-
vice drivers (including the built-in audio on Mac
computers using Core Audio).

Complete Production Toolkit 2
Authorization

A Complete Production Toolkit 2 authorization
(in addition to Pro Tools 9.0 authorization) lets
you run Pro Tools 9.0 with Complete Produc-
tion Toolkit 2 functionality. Pro Tools 9.0 with
Complete Production Toolkit 2 is supported
with Pro Tools audio interfaces, M-Audio audio
interfaces, or any third-party audio interface
with supported Core Audio (Mac) or ASIO (Win-
dows) device drivers.

For more information about Complete Pro-
duction Toolkit 2, see the Complete Produc-
tion Toolkit 2 Guide.

6 What’s New in Pro Tools 9.0

Core Audio Support

Apple’s Core Audio provides audio stream con-
nectivity between software applications and au-
dio hardware on Mac OS X. Pro Tools 9.0 is com-
patible with third-party audio interfaces with
Core Audio device drivers on Mac computers.

Pro Tools software can use audio interfaces with
compatible Core Audio drivers for playback and
recording with up to 32 channels of I/O.

Additionally, Pro Tools hardware continues to
provide Core Audio drivers for use with
third-party Core Audio software applications.

ASIO Support

Steinberg’s Audio Stream Input/Output (ASIO)
provides audio stream connectivity between
software applications and audio hardware on
Windows. Pro Tools 9.0 is compatible with
third-party audio interfaces with ASIO device
drivers on Windows computers.

Pro Tools software can use audio interfaces with
compatible ASIO drivers for playback and re-
cording with up to 32 channels of I/O.

Additionally, Pro Tools hardware continues to
provide ASIO drivers for use with third-party
ASIO software applications.



New Pro Tools System
Settings

New Playback Engine Settings

Pro Tools lets you adjust the performance of
your system by changing system settings that
affect its capacity for processing, playback, and
recording. These system settings are available in
the Playback Engine (Setup > Playback

Engine).

Playback Engine

Current Engine: HD TDM s
Settings
H/W Buffer Size: | 256 Samples )]
Host Processors: | B Processors =)
CPU Usage Limit: | 85 % =]

Host Engine: || Ignore Errors During Playback/Record
(may cause clicks and pops)

Number of Voices: | 32 Voices (1 DSP) 1]

Sample Rate:  44.1 kHz

Delay C: Engine: [ Long =)
DAE Playback Buffer (disk buffer)
Size: [ Level 2 & Cache Size: | Normal =]

Lower values for the disk buffer reduce disk latency (system more respansive). Higher
values improve disk performance (system less responsive).

Reguires 22MB of system memory. You currently have 125ME allocated.

] Minimize system memory allocation (takes effect at next restart).

Plug-In Streaming Buffer
size: [ Level 2 ]

(] Optimize for streaming content on audic drives (requires more system memaory)

OK

Playback Engine for Pro Tools |HD system

Current Engine

Pro Tools 9.0 provides a new system setting for
selecting the audio engine for Pro Tools to use
with your audio interface. The available options
are determined by which audio interfaces are
connected and have compatible drivers in-
stalled.

Changing the Current Engine setting can be use-
ful if you have multiple audio interfaces con-
nected to your computer with different routing
configurations in your studio, or if you want to
prepare a session for use with a specific interface
on a different system (for example you might
want to prepare a session created on your HD
system for use with the built-in audio on your
Mac laptop).

To select the audio engine for Pro Tools to use
with your audio interface:

1 Choose Setup > Playback Engine.

2 From the Current Engine selector, select your
audio interface:
¢ For Pro Tools|HD and Pro Tools|HD Native
systems, use the default setting of HD TDM
or HD Native.

e For supported Pro Tools and M-Audio au-
dio interfaces (such as the Mbox Pro or Pro-
Fire 2626), selecting the name of the
corresponding interface uses the Direct I/O
engine for Pro Tools.

e For third-party audio interfaces with com-
patible CoreAudio (Mac) or ASIO (Win-
dows), select the name of the
corresponding Core Audio (Mac) or ASIO
(Windows) compatible audio interface.

¢ On Mac systems, if you are using built-in
audio, select any of the available built-in
options for playback or select Pro Tools Ag-
gregate 1/0 for simultaneous input and out-
put with the built-in I/O hardware options.

3 Click OK.

When changing engines with a Pro Tools ses-
sion open, Pro Tools must close and relaunch
the session to be able to initialize the new en-
gine.
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On Pro Tools|HD systems, changing engines re-
quires that you quit and relaunch Pro Tools for
the new setting to take effect.

Q When changing engines on any Pro Tools
~ system, you may need to reset the default
1/0 settings to match the selected audio in-
terface.

Pro Tools Aggregate 1/0
(Mac Only)

On Mac systems using Core Audio, you can use
Pro Tools with the built-in audio inputs and
outputs on your Mac by selecting any of the
available built-in inputs and outputs, or by se-
lecting the Pro Tools Aggregate |/0 option for us-
ing a combination of built-in inputs and out-
puts simultaneously (for recording and
monitoring).

Current Engine: | ¥ HD TOM
Ozonic
Built-in Line Input
Built-in Digital Input
Built-in Output
Built-in Line Qutput
Built-in Digital Output ~ —

T HOSTENgINEr | lghore Errors During Playback/Record
(may cause clicks and pops)

Settings

i

-

Selecting Pro Tools Aggregate I/0 in the Playback
Engine (Mac only)

You can configure the Input and Output op-
tions for Pro Tools Aggregate I/O in the Mac Au-
dio Setup, which can be accessed from the

Pro Tools Hardware Setup (see “Configuring
Built-in or Pro Tools Aggregate I/O” on page 9).

Q If you need simultaneous input (recording)
- and output (playback and monitoring) with
Pro Tools using the built-in audio options
on Mac, use the Pro Tools Aggregate 1/O op-
tion. If you only need to playback audio for
editing and mixing, select the appropriate
built-in audio output option.
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New Pro Tools Hardware
Settings

Pro Tools lets you configure the signal routing,
digital I/O format, default sample rate, clock
source, and other hardware-based settings de-
pending on your system configuration. These
system settings are available in the Hardware
Setup (Setup > Hardware).

Pro Tools 9.0 lets you configure the hardware
settings for any audio interfaces associated with
the selected Current Engine setting in the Play-
back Engine dialog: Pro Tools|HD, Pro Tools,
M-Audio, or other third-party Core Audio (Mac)
or ASIO (Windows) audio interfaces connected
to your Pro Tools system.

Peripherals
MOTU Audio ASIO

Hardware controls for this peripheral are handed i its Setup Application.

Launch Setup App

MOTU Audio ASIO

Hardware Setup for an ASIO device

Selecting an Audio Interface to
Configure

The Peripherals list in the Hardware Setup lets
you select any audio interface connected to your
Pro Tools system associated with the selected
Current Engine setting in the Playback Engine di-
alog.

For Pro Tools|HD audio interfaces (such as

HD OMNI or HD I/O) you can configure the
signal routing, digital I/O format, default sample
rate, clock source, and other hardware-based
settings for each HD peripheral connected to
your system.



For Pro Tools audio interfaces (such as 003 or
Mbox) you can configure the signal routing, dig-
ital I/O format, default sample rate, clock
source, and other hardware-based settings de-
pending on your system configuration.

For M-Audio audio interfaces and third-party
Core Audio (Mac) and ASIO (Windows) compat-
ible audio interfaces, use the Launch Setup App
button to launch the control panel for configur-
ing your specific audio interface.

Launch Setup Application

Using the setup application (control panel) for
your audio interface, you can change settings in
the following areas depending on your audio in-
terface:

e Mixer Settings
e QOutput Settings

e Hardware Settings (including sample rate,
hardware buffer size, and sync source).

Q You can set the sample rate when creating a
" new Pro Tools session by selecting a differ-
ent sample rate in the New Session dialog.
(Refer to the Pro Tools Reference Guide for
details.)

To change control panel settings:

1 In the Hardware Setup dialog, click the Launch
Setup App button.

2 To change settings in the Control Panel, refer
to the documentation that came with your au-
dio interface.

3 When finished, close the Control Panel.

Configuring Built-in or Pro Tools Aggregate 1/0
(Mac Only)

On Mac systems using Core Audio, you can any
of the built-in I/O options or the Pro Tools Aggre-
gate |/0 option as the Current Engine for using
the built-in audio inputs and outputs on your
Mac computer. You can configure the built-in
option or the Pro Tools Aggregate 1/0 option in
the Mac Audio Setup, which can be accessed
from the Pro Tools Hardware Setup dialog.

To configure the built-in audio or the Pro Tools
Aggregate 1/0 settings:

1 Choose Setup > Hardware.

2 In the Peripherals list, select the built-in auto

option or the Pro Tools Aggregate /0 option (the
Current Engine setting in the Playback Engine di-
alog determines which option is available in the
Peripherals list in the Hardware Setup dialog).

Pariphanat
Pra Tocks Aggregiss B0

s Tosh Aggregine WD

ok

Hardware Setup for Pro Tools Aggregate 1/0 (Mac only)

3 Click the Launch Setup App button.
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4 In the Audio Devices window of the Mac Au-
dio Setup, configure the corresponding Built-in
audio options or the Pro Tools Aggregate 1/O op-
tion as desired.

A0 fuadio Dyricss .
Buitt-in Line Input Pro Tools Apgregats 1/O
¥ # | Clock Seares: | Builr-in Lina nput [ m
Built=in Digita input
2 ad v In Out Besample
Buiki-in Qutpet o g s
h w2 cw| M xy o
B Buift-in Lise Outout 02
a gl Lo e ] Buihein Dégial nput : o
= Budlt-in Digal Sutput o2
) 1 D ot = s
idenign HW (HD )
pal 0
v+ _WHD
Buikt=in Line Input
im0t Q
Built-in Cutput
Built-in Line Cutput
Ozanic Mulicaannal
diia
T =87 1 {_ Confgure Speakers . |

Configuring Pro Tools Aggregate I/0 in the Audio
Devices window of the Mac Audio Setup (Mac only)

5 Quit the Mac Audio Setup.
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Mixing and Recording Features and

Enhancements

Increased Number of Audio
and MIDI Tracks, and Internal
Mix Busses

Pro Tools HD 9.0 and Pro Tools with Complete
Production Toolkit 2 increase the number of
available voiceable audio tracks to 512. Any au-
dio tracks beyond that system’s voiceable track
limit will be automatically set to Voice Off.

Pro Tools 9.0 increases the number of available
voiceable audio tracks to 128. Any audio tracks

All versions of Pro Tools 9.0 provide up to 256
internal mix busses. All versions of Pro Tools 9.0
also provide up to 512 MIDI tracks.

Table 4 on page 11 lists the audio playback, re-
cording, and voiceable track limits of each type
of Pro Tools system. Playback and recording
voices refer to the number of unique simultane-
ous playback and record tracks on your system.
Total voiceable tracks refers to the maximum
number of audio tracks that can share the avail-
able voices on your system. (Mono tracks take
up one voice. Stereo and multichannel tracks

beyond that system’s voiceable track limit will
be automatically set to Voice Off.

take up one voice per channel.)

Table 4. Pro Tools system audio playback, recording and voice limits

Playback and Recording
Sample Voices (Mono Tracks of Total
Core System Type Maximum I/0 Rate (kHz) Simultaneous Playback Voiceable
. Tracks
and Recording)
Pro Tools|HD 1 32 channels 44.1/48 96 512
88.2/96 48 512
176.4/192 24 512
Pro Tools|HD 2, 64 channels (HD 2) 44.1/48 192 512
Pro Tools|HD 3, 96 channels (HD 3)
or any expanded or up to 88.2/96 96 512
Pro Tools|HD system 160 channels (HD 5)
176.4/192 36 512

Chapter 3: Mixing and Recording Features and Enhancements 11



Table 4. Pro Tools system audio playback, recording and voice limits

Playback and Recording
. Sample Voices (Mono Tracks of ToFaI
Core System Type Maximum I/0 Rate (kHz) Simultaneous Playback Voiceable
. Tracks
and Recording)
Pro Tools|HD Native 64 channels 44.1/48 192 512
88.2/96 96 512
176.4/192 48 512
Pro Tools 32 channels 44.1/48 96 (mono or stereo) 128
88.2/96 48 (mono or stereo) 128
176.4/192 24 (mono or stereo) 128
Pro Tools with 32 channels 44.1/48 192 512
Complete Production
Toolkit 2 88.2/96 96 512
176.4/192 48 512
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New Track and Send Output
Selector Commands

Pro Tools 9.0 offers two new commands to the
Output selector for assigning tracks and sends to
new tracks or existing tracks.

Create and Assign New Track from Send or
Track Output

Pro Tools 9.0 lets you create a new Auxiliary In-
put, Audio, or Instrument track from a track or
send Output selector. When you create a new
track in this way, the source track (or send) out-
put is automatically assigned to an available in-
ternal mix bus, as is the input for the newly cre-
ated track.

To create a new track from a send or track output:

1 On an existing track, click the Output selector
for a send or for the track and select New Track.

Option-click (Mac) or Alt-click (Windows)
to set all track outputs or send (of the same
slot) outputs to the new track.

Option-Shift click (Mac) or Alt-Shift-click
(Windows) to set all selected track or send
(of the same slot) outputs to the new track.

2 In the resulting New Destination dialog, select
the desired Width, Type, and Time Base for the
new track.

wae [Smvo ] Teee | Aanieme

[ P

New Destination dialog

3 Type a Name for the new track.

Chapter 3: Mixing and Recording Features and Enhancements

The name entered is used for both the new track
and the new mix bus. (For example, if you en-
tered the name “Drum Sub,” Pro Tools creates a
new Auxiliary Input track named “Drum Sub”
and also creates an internal mix bus named
“Drum Sub.”)

4 Select (or deselect) whether you want the new
track to be created next to the current track or at
the bottom of the Track List.

5 Click OK.

Pro Tools creates a new track with the output of
the originating track or send automatically
routed to the input of the new track using the
first available internal mix bus.

SENDS A-E

SENDS A-E

Audlo 1 a
main out
Drum Sub

New Auxiliary Input track with audio track send
automatically assigned to an internal mix bus named

“Drum Sub”

13
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Assign Existing Track from Send or Track
Output

Pro Tools 9.0 lets you assign the output of a
track or send directly to an active audio, Auxil-
iary Input, or Instrument track using any avail-
able internal mix bus.

To assign the output of a track or send to an
available input on an existing track:

1 On an existing track, click the Output selector
for a send or for the track and select Track.

2 From the Track submenu, select the destina-
tion track you want. The destination track must
be set to either an internal mix bus or to No Input
in order to be available for assignment.

SENDS A-E
¥ nosend

SENDS A-E SENDS A-E

output
bus

new track...
track Aux 1(Steren) [
Aux 2(Stereo) 5

AUTO

Assigning a track output to an existing Auxiliary Input
track

Pro Tools automatically routes the track or send

to the input of the selected track using an avail-

able internal mix bus.

What’s New in Pro Tools 9.0

Variable Stereo Pan Depth

Pro Tools 9.0 lets you select the pan depth for
stereo output paths. You can set the Pan Depth
in the Session Setup window. The Pan Depth set-
ting lets you set the amount of signal attenua-
tion when a track is routed to a stereo output
and panned to center.

“EYNE Seliin & Tiine Code Offaels”
i it Mg

Session Setup window

Q The Pan Depth setting is a session setting,
" which is stored with and recalled from the
session (rather than the system).

A\ On Pro Tools|HD systems only, if the Stereo
Mixer plug-in is installed in the Plug-ins
folder, the Pan Depth setting defaults to
—2.5 dB and cannot be changed. Move the
Stereo Mixer plug-in to the Plug-ins (Un-
used) folder to be able to change the Pan
Depth setting.

To set the stereo pan depth:

1 Choose Setup > Session to open the Session
Setup window.

2 Select the desired option from the Pan Depth
selector.

44.1 kHz
24-bit
See Control Panel

.~ SYNC Setup &
TimBlGoaBSatings

Session Setup window



The following Pan Depth options are available:

-2.5 This is the standard stereo pan depth set-
ting in Pro Tools 8.x and lower. When opening
Pro Tools 8.x or lower session in Pro Tools 9.0 or
higher, this is the default option.

-3.0 This is the industry standard for surround
mixers and many consoles. This is the default
setting for new Pro Tools 9.0 sessions.

-4.5 This is the standard for many British ana-
log consoles.

—6.0 This is the standard for full mono compat-
ibility.

A\ Pan depth on multi-channel formats (such
as LCRor 5.1) is fixed at —3.0 dB. The vari-
able pan depth setting only affects stereo
panning.

7.1 and 7.0 Surround Formats

(Pro Tools HD and Pro Tools with Complete
Production Toolkit 2 Only)

Pro Tools HD and Pro Tools with Complete Pro-
duction Toolkit 2 support two 7.0/7.1 surround
formats: standard HD and SDDS.

Standard HD 7.1 and 7.0 Surround
Formats

Pro Tools 9.0 supports the standard HD 7.1 and
7.0 surround formats. HD-DVD and Blue-Ray
systems use the standard HD format, which uti-
lizes the following track layout:
e 3 front channels (Left, Center, Right)
e 2 side channels (Left Surround Side, Right
Surround Side)
e 2 rear channels (Left Surround Rear, Right
Surround Rear)
e 1 LFE channel (x.1 only)

SDDS 7.1 and 7.0 Surround
Formats

The Sony Dynamic Digital Sound (SDDS) 7.1
and 7.0 surround formats that Pro Tools has
supported since version 5.1 have been renamed
“7.1 SDDS” and “7.0 SDDS” to differentiate
these formats from the standard 7.1 and 7.0 sur-
round formats.

e 5 front channels (Left, Left Center, Center,

Right Center, Right)
e 2 rear channels (Left Rear, Right Rear)

e 1 LFE channel (x.1 only)

Chapter 3: Mixing and Recording Features and Enhancements
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EUCON Support

Pro Tools 9.0 supports “EUCON-aware” control
surfaces. EUCON is a high-speed Ethernet proto-
col that enables control of software applications
such as Pro Tools by EUCON-compatible con-
trollers.

To enable EUCON control in Pro Tools:

1 Choose Setup > Peripherals.
2 Select the Ethernet Controllers tab.

3 Select the Enable EUCON option.

Peripherals

Machine Control MIDI Controllers Ethernet Controllers | Mic Preamps

Ethernet Port

(] Enable

#2 none . Name.
#3
#4
#5

#6

#7

# Enable EUCON

Enable EUCON option selected in the Ethernet
Controllers page of the Peripherals dialog

4 Click OK.
When the EUCON option is selected, Pro Tools is

enabled for control by one or more hardware
controllers using the EUCON control protocol.

For information about setting up Pro Tools
for use with EUCON-compatible controllers,
see the Pro Tools EUCON Guide.

16 What’s New in Pro Tools 9.0



chapter 4

Import and Export Options

Advanced Import Session
Data Options

Pro Tools 9.0 provides advanced Import Session
Data options that were previously only available
with Pro Tools HD, Pro Tools LE with DV Tool-
kit 2, or Pro Tools LE with Complete Production
Toolkit.

The Import Session Data dialog lets you view the
properties of a session, select which tracks to im-
port, and choose which attributes of those tracks
you want to import into the current session.

For more information on Import Session
Data, see the Pro Tools Reference Guide.

Importing and Exporting AAF
and OMF Sequences

Pro Tools 9.0 lets you import and export AAF
and OMF sequences. Lower versions of

Pro Tools require the DigiTranslator 2.0 option
to be able to import and export AAF and OMF
sequences. All DigiTranslator 2.0 functionality
is now included with Pro Tools 9.0.

For more information about importing and
exporting AAF and OMF sequences, and
MXF files, to and from Pro Tools, see the
Pro Tools Reference Guide.

Improved AAF Import Capabilities

Pro Tools 9.0 offers expanded functionality
when importing AAF sequences and audio
tracks.

Importing Stereo AAF Audio Tracks

Pro Tools 9.0 lets you import stereo tracks from
AAF sequences to new or existing stereo audio
tracks in Pro Tools. Lower versions of Pro Tools
could only import only mono tracks from AAF
sequences.

For more information on importing AAF au-
dio tracks and sequences into Pro Tools, see
the Pro Tools Reference Guide.

@ When importing stereo AAF audio tracks
into Pro Tools, the “Pan Odd Tracks
Left/Even Tracks Right” setting in the Im-
port Session Data window is greyed out and
unavailable.

Chapter 4: Import and Export Options
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Importing RTAS Plug-in Data From AAF
Sequences

Avid Media Composer (version 5 and higher)
lets you process audio tracks with RTAS (Real
Time AudioSuite) plug-ins. Pro Tools 9.0 lets you
import RTAS plug-in data from audio tracks in
Media Composer—generated AAF sequences.

A\ Pro Tools 9.0 does not export RTAS plug-in
data when exporting an AAF for use with
Media Composer. Because Pro Tools mixes
often contain complex busing, routing, and
plug-in automation, tracks should be
printed or bounced to retain new processing
changes before exporting to AAF.

New Import AAF and OMF
Translation Options

Pro Tools 9.0 provides a new Import Translation
option and slight changes to two existing op-
tions when importing AAF and OMF sequences.

: lgnore rendered audio effects

lgnore clip-based gain ﬂ

: lgnore auto-gain
E Pan odd tracks left/even tracks right

Locators Te Import: All kd

Translation settings
Ignore Auto-Gain

Keyframe gain is referred to as “Auto-Gain” in
Media Composer, and has been renamed in

Pro Tools to match. The Ignore Keyframe Gain op-
tion is now the Ignore Auto-Gain option.

18 What’s New in Pro Tools 9.0

Pan Odd Tracks Left/Even Tracks Right

The Pan Odd Tracks Left/Even Tracks Right setting
enables you to set the basic track pan setting so
that odd-numbered tracks translate with full-left
panning, and even-numbered tracks translate
with full-right panning. However, when import-
ing stereo AAF audio tracks into Pro Tools, the
Pan Odd Tracks Left/Even Tracks Right setting in
the Import Session Data window is greyed out
and unavailable.

Locators To Import

Pro Tools 9.0 lets you import Media Composer
locators as Pro Tools markers. The Locators to
Import menu lets you choose to import all loca-
tors, no locators or locators of certain colors.

To import all locators:

= Click the Locators to Import menu and
choose All.

To import no locators,

= Click the Locators to Import menu and
choose None.

To import locators based on locator color,

1 Click the Locators to Import menu.

2 Select the colors of locators you want to im-
port. Check marks will appear next to the colors
you choose.



Avid Interplay Support on Mac

Avid Interplay now supports Mac clients.

Pro Tools 9.0 lets you to access the Avid Inter-
play networked file management system on an
Avid-qualified Mac system.

For more information on using Avid Inter-
play with Pro Tools, see the Pro Tools Avid
Interplay Guide.

Check Data Into and Out of
Avid Interplay with Interplay
Access

In previous versions, Pro Tools had a limited-
functionality tool for accessing files on Interplay
servers. Pro Tools 9.0 directly supports the Inter-
play Access browser, which offers expanded
functionality for previewing, searching, and
sorting media.

To check out a sequence from Interplay and import
it into Pro Tools using Interplay Access:

1 Start Pro Tools.

2 If you want to import the sequence into an ex-
isting session, open that session.

3 Choose File > Import > Sequence from Avid Inter-
play. The Interplay Access window appears.

4 In the Interplay Access window, expand the
Interplay database by clicking the plus sign (+)
next to it.

5 Expand the root folder of the database—usu-
ally titled AvidWG or a variation thereof—by
clicking the plus sign (+) next to its name.

6 Expand the Projects folder.

7 Expand the project containing the sequence
you want to check out and import to Pro Tools.

8 The Logon to Interplay dialog appears.

9 Enter your username and password, and click
OK.

10 In the Interplay Access window, locate and
select the sequence that you want to import.

11 Click OK.

12 If the Name the Session dialog appears, nav-
igate to the appropriate location either on local
storage or on a dedicated workspace on the net-
work, and click Save.

Q This dialog does not appear if you are im-
~ porting a sequence into an existing session.
If the Pro Tools Import Session Data dialog
appears, select the appropriate options and
click OK.

Q This dialog does not appear if you are im-
" porting a sequence into an existing session.
If the Pro Tools Import Session Data dialog
appears, select the appropriate options and
click OK.

13 Pro Tools imports the sequence, copies any
media (if the settings require copying), and dis-
plays the imported sequence within the

Pro Tools session.

If the sequence was linked to media files on un-
mounted volumes, the system provides a warn-
ing and asks you to mount those volumes before
you proceed with copying or linking to media.

For more information on using Avid Inter-
play with Pro Tools, see the Pro Tools Avid
Interplay Guide.

Chapter 4: Import and Export Options
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Export MP3

Pro Tools 9.0 lets you export MP3 files. Lower
versions of Pro Tools require the MP3 Export op-
tion to be able to export MP3 files.

To export an MP3 from Pro Tools:

1 Do one of the following:

¢ Select a region and use the Export Selected
Region as File command.

e Use the Bounce to Disk command.
2 For File Type, select MP3.
3 Configure other settings as desired.
4 Click Export or Bounce.
5 Set the MP3 settings as desired (see below).

6 Click OK.

For more information about exporting MP3
files from Pro Tools, see the Pro Tools Refer-
ence Guide.

20 What’s New in Pro Tools 9.0

Export Sessions as Text

Pro Tools 9.0 now provides the Export Session
Info as Text command for all versions of

Pro Tools. In lower versions of Pro Tools, the Ex-
port Session Info as Text command was only
available in Pro Tools HD. Use the Export Ses-
sion Info as Text command to create a text file
that contains extensive information about your
session.

This text file can contain a list of audio files, au-
dio regions, audio track EDL (Edit Decision List)
information, extended timestamp information,
and information about crossfades.

Track EDLs are exported as tab-delimited text—
that is, with tabs between each column heading,
and tabs between each event parameter. You
can use this data in a program for reading EDLs,
or you can format the EDL data into tables using
a word processor or spreadsheet application.

For more information about Export Sessions
as Text command, see the Pro Tools Refer-
ence Guide.



1/0 Setup Improvements

Pro Tools 9.0 provides I/O Setup improvements
for all Pro Tools systems that were first intro-
duced in Pro Tools HD 8.1. These changes have
been made in order to solve session interchange
issues (such as maintaining studio settings when
exchanging sessions between different Pro Tools
systems) and to provide better overall workflows
for session interchange.

In lower versions of Pro Tools, I/O settings are
recalled from the Pro Tools session document,
so studio settings corresponding to your hard-
ware could potentially change each time a ses-
sion is opened. This can result in a temporary
loss of monitor paths.

In Pro Tools 9.0, I/O settings can be recalled
from the system. This means that your studio
settings can be maintained when opening ses-
sions created on other Pro Tools systems.

See the 1/O Setup Primer or the Pro Tools
Reference Guide for more detailed informa-
tion on configuring the 1/0 Setup.

System Settings vs. Session
Settings

In Pro Tools 9.0, I/O settings (Input, Output, In-
sert, Mic Preamps, and H/W Insert Delay set-
tings) are system settings. These settings are
stored with the system and the session file, and
they can be recalled from either. When opening
a session created or edited on another system,
you can choose whether or not the I/O settings
stored with the session overwrite I/O settings
stored with your system.

See “Sessions Overwrite Current I/O Setup
When Opened” on page 22.

Use this feature along with customized I/O set-
tings to improve workflows when exchanging
sessions between Pro Tools systems.

See “Session Interchange” on page 30.

In Pro Tools 8.0.4 and lower, I/O settings are ses-
sion settings. They are stored and recalled from
the session. When opening a session created or
edited on another system, any studio settings
configured for your system are overwritten by
the settings stored with the session file.

Chapter 5: 1/0 Setup Improvements
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Sessions Overwrite Current 1/0
Setup When Opened

This option determines whether or not, when
opening a session, Input, Output, and Insert [/O
settings as currently configured on your system
will be overwritten by any of these I/O Settings
stored with a session. These settings are always
stored with the session as well as with the sys-
tem.

*C¥ Enable the Sessions Overwrite Current /0
Setup When Opened option for legacy
Pro Tools behavior (versions lower than
9.0). This option is enabled by default.

T
(" New Path... )

—_———
| Default )

Default Monitar Format: | Stereo - LR

5.1 Path Order: [ LR C LFE Ls Rs

kot

: Sessions overwrite current |/O Setup when opened

1/0 Setup dialog showing Sessions Overwrite button

¢ When the Sessions Overwrite Current |/0 Setup
When Opened option is disabled, Pro Tools re-
calls these settings from the system. The output
bus paths of the session automatically remap to
the system output paths according to certain cri-
teria (see “Path Names and Automatic Output
Bus Remapping” on page 30).

¢ When the Sessions Overwrite Current |/0 Setup
When Opened option is enabled (default),

Pro Tools recalls these settings from the session
rather than the system. The output bus paths of
the session remain mapped to the output paths
saved with the session.
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The Sessions Overwrite Current 1/0 Setup When
Opened option is available in the Input, Output
Bus, and Insert pages of the I/O Setup. Enabling
or disabling this option in one page affects all of
the other pages as well.

When to Enable (or Disable) the
“Sessions Overwrite Current 1/0 Setup
When Opened” Option for Optimal
Session Interchange

When exchanging sessions among different sys-
tems running Pro Tools 9.0, it is generally rec-
ommended that the Sessions Overwrite Current
I/0 Setup When Opened option be disabled. This
maintains your custom system settings and

Pro Tools automatically remaps session output
busses to the system output paths when open-
ing sessions created (or edited and saved) on
other systems.

When exchanging sessions with systems run-
ning lower versions of Pro Tools, it is generally
recommended that the Sessions Overwrite Cur-
rent /0 Setup When Opened option be enabled.
In this case, any custom settings saved with the
session that do not match your system may need
to be reconfigured in the I/O Setup.

For more information, see “Session Inter-
change” on page 30.



Busses

Pro Tools 9.0 provides two types of busses:
¢ Internal Mix Busses

e Output Busses

Internal Mix Busses

Pro Tools 9.0 provides up to 256 internal mix
busses. Internal mix busses in Pro Tools 9.0 are
the same as those in lower versions of Pro Tools.
Use internal mix busses to route audio signal
from track outputs and sends to other track in-
puts. Common uses for internal mix busses in-
clude effects sends and returns (such as bussing
sends from audio tracks to an Auxiliary Input
track for plug-in effects processing) and bus re-
cording.

Output Busses

In addition to internal mix busses, Pro Tools 9.0
and higher provide output busses, which appear
along with internal busses on the Bus page of
the I/O Setup. When you create a new output
path on the Outputs page, an output buss is au-
tomatically created and routed (mapped) to the
corresponding output path. Output paths are as-
signed to the system'’s physical audio outputs in
the I/O Setups Grid.

Q Internal mix busses can also be mapped to
" any output path. Busses can be unmapped
at any time.

Because Bus settings are saved with and recalled
from the session, when moving sessions be-
tween Pro Tools systems, the output bus routing
from tracks and sends in the Pro Tools mixer is
maintained.

Q To better understand how output busses
work in 1/O Setup, consider how an analog
console works. In Pro Tools, the output bus
is equivalent to a console's bus system. The
output bus as defined on the left side of the
Bus page in the Pro Tools I/O Setup is anal-
ogous to the outputs on a console's patch-
bay. The Mapping to Output selector is like
the patch cords used to patch into the stu-
dio’s various audio feeds, which in turn are
like the physical output paths in Pro Tools.

Creating and Mapping Busses to
Outputs

Any available bus can be mapped to any of the
available output paths of the same channel
width or greater. For example, a mono bus can
be mapped to a mono output path, a stereo bus
can be mapped to a stereo output path, anda 5.1
surround bus can be mapped to a 5.1 surround
output path.

To create a bus and map it to an output path:

1 On the Bus page of the I/O Setup, click New
Path.

2 In the New Paths dialog, specify the number
of new paths you want to create, the channel
width for each path, and the path name.

New Paths

Create 1 new [ Stereo B8] path  MAN #

9 Add delault channel assignments
[ Autc-creste sub paths

( Cancel ) ( Creme )

New Paths dialog

10 Setup Improvements
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3 Click Create to create the new paths.

Ingut  Output Bus  Wsert M Preamips  HIW Masert Delay
e e S Channels
s A M seereo L R
. T = e ]
e ASE | seren |1 R [l ASE
e AT-B LETE N £ AT-B |
— —

Unmapped “MAIN” output bus
4 Enable Mapping To Output for the bus path.

5 Select the desired output path from the Map-
ping To Output selector.

Input  Output Bus nsert Mt Preampsd H/W Msert Delay
T e TS Channels
s A1z | S0 L R { |
e Adg | seren |1 R Ml A 35 Seeren)
w ASB @ seeo (L ow | A5G aeres)
» | A78 il —Srereo 10L& ATCH )
S —

Mapping the “MAIN” output bus to output path ‘A 1-2”

Any signals from tracks or sends sent to the bus
are now sent to the hardware outputs assigned
to the corresponding Output paths.

To map all output busses of the same format to an
output path:

= Option-click (Mac) or Alt-click (Windows) any
Mapping To Output selector and select the de-
sired output path (mono or stereo).

All mapped output busses of the same format
(such as stereo) are all assigned to the same out-
put path. For example, you can assign all stereo
output busses to output path A 1-2.
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To map all output busses of the same format to
one output path:

1 Do one of the following:

¢ Shift click to select contiguous Output bus-
ses.

e Command-click (Mac) or Control-click

(Windows) to select noncontiguous Output
busses.

2 Option-Shift click (Mac) or Alt-Shift-click
(Windows) the Mapping To Output selector for
one of the selected Output busses and select the
desired output path (mono or stereo).

Only the selected mapped output busses of the
same format (such as stereo) are assigned to the
same output path. For example, you can assign
only the selected stereo output busses to output
path A 1-2.

To map all busses of the same format to unique
ascending output paths (cascading):

= Command-Option-click (Mac) or Control-Alt-
click (Windows) the Mapping to Output selector
of the top-most output path and select the first
output path.

All busses of the same channel format are auto-
matically assigned to unique output path as-
signments in ascending order. For example, for
stereo output paths, output bus A 1-2 is as-
signed to output path A 1-2, A3-4to A 3-4, A
5-6 to A 5-6, and so on.



Resetting Busses

When you open a session that was created with
Pro Tools any lower version of Pro Tools on a
current version of Pro Tools, only the number of
busses supported on the original system are ini-
tially available.You can reset the number of
available internal mix busses in your session to
match your system’s full capabilities by revert-
ing to the default bus configuration.

Q Pro Tools 9.0 creates 128 (out of 256) inter-
" nal busses by default.

To revert to the default bus configuration for your
system:

1 Open the I/O Setup.
2 Click the Bus tab in the upper left.
3 From the pop-up menu to the right of the De-
fault button, select one of the following:
¢ All Busses

e Qutput Busses

* Internal Busses
4 Click Default.
A\ Resetting busses to the default setting will

rename all busses to their default name
(Bus 1-2, Bus 3—4, and so on).

5 Click OK to save changes and close the I/O
Setup.

Importing 1/0 Settings

In Pro Tools 9.0, the Import Settings button lets
you import the settings for only the currently
viewed page of the I/O Setup. For example, if
you are viewing the Input page and import I/O
Settings, only the settings for the Input page are
imported. This helps avoid overwriting your
custom I/O Settings on other pages. In lower
versions of Pro Tools, importing I/O Settings al-
ways imports settings for all pages in the I/O
Setup.

When you import I/O Settings, you can choose
to delete any unused path definitions before im-
porting the new paths, or leave unused path def-
initions intact and add the new paths to the cur-
rent I/O Setup configuration.

For more information on importing and ex-
porting 1/O settings, see the I/O Setup
Primer or the Pro Tools Reference Guide.

To import 1/0 Settings:

1 Click the tab for the page of the I/O Setup for
which you want to import settings.

2 Click Import Settings.

Option-click (Mac) or Alt-click (Windows)
the Import Settings button to import set-
tings to all pages of 1/O Setup.

3 Select an I/O settings file in the Import Set-
tings dialog and click Import.

10 Setup Improvements
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4 A dialog appears asking whether you want to
delete existing paths. Do one of the following:

¢ Click Yes to remove any unused paths and
add the imported paths to the current I/O
Setup configuration. Any 1/O assignments
and automation data associated with the
unused paths are also deleted.

— Or —

e Click No to add the imported paths to the
current I/O Setup configuration.

If the import results in overlapping paths, the
new paths will appear in the I/O Setup as Inac-
tive.

Q You can also import I/O paths and path
° names, as well as other session data, from a
different session by using the Import Session
Data command (File > Import > Session
Data). See the Pro Tools Reference Guide for
more information.

Overlapping Paths

In Pro Tools 9.0, you can create overlapping out-
put paths—multiple paths that can share the
same physical output assignments. This can be
especially useful if you are working with multi-
ple monitoring configurations of different chan-
nel widths.

Q In Pro Tools 8.1 and higher, you cannot cre-
" ate output sub-paths. Use overlapping out-
put paths as you used output sub-paths in
Pro Tools 8.0.4 or lower.

For example, you may want to switch monitor-
ing between discrete surround (such as 5.1) and
basic stereo, but without having to have two

completely different sets of monitors. To be able
to switch between the two, you can create a 5.1
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output path that maps to output channels 1-6
(L, C, R, Ls, Rs, LFE) and also have a stereo out-
put path that maps to output channels 1 and 3
(L, R).

! Input | Qutput | Bus  Insert  Mic Preamps  H/W Insert Delay
A
HD 170 #1

Name Format |*%

Surround 5.1
Stereo Main Stereo
Stere Surround Stereo L|r

AT7-8 Stereo LR
—

o
B ™
F
&

Overlapping output paths

Note that overlapping paths must overlap com-
pletely. For example, you can have a 5.1 path
mapped to channels 1-6 and a stereo path
mapped to channels 1 and 3 because the stereo
path is “contained” by the 5.1 path. As another
example, you can have two separate stereo paths
assigned to channels 1-2, but you cannot have
one stereo path assigned to channels 1-2 and
the other assigned to 2-3 since they only par-
tially overlap.

A\ With overlapping output paths of different
channel widths, if the widest path is made
inactive, all other overlapped output paths
will not pass audio from Pro Tools.

@ See “Path Order and Overlapping Output
Paths” on page 31 for information on over-
lapping path sub-path and behavior when
exchanging sessions between systems run-
ning different versions of Pro Tools.



Input and Output Signal
Routing

To better understand the routing of audio sig-
nals to and from physical I/O and the Pro Tools
mixer, consider the following two examples.

Signal Path Routing for Audio
Input

Figure 1 on page 28 shows the signal path from
the physical analog input of an HD OMNI audio
interface, and then through the Pro Tools audio
input path to the Input of an audio track in the
Pro Tools mixer:

(1) Physical Input For Pro Tools|HD interfaces
such as the HD OMN], the physical inputs that
are available to Pro Tools are set on the Main
page of the Hardware Setup (this selector is mir-
rored in the Input page of the I/O Setup).

Q For Pro Tools systems such as the Mbox and
the 003, physical inputs are fixed. For third-
party and built-in hardware, click the
Launch Setup App button for available con-
figuration options.

(2) Input Path Main input paths and sub-paths
are routed (patched) to physical inputs using
cross-point matrix mapping in the I/O Setup. In
this example, audio input is routed from HD
OMNI physical inputs Analog 1-2 to Pro Tools
Input channels A 1-2.

(3) Track Input Input paths and sub-paths are
routed to track inputs in the Pro Tools mixer by
selecting the path (or sub-path) from the Track
Input selector. In this example, input sub-path
A1 is routed to the input of track “Audio 1.”

Signal Path Routing for Audio
Output

Figure 2 on page 29 shows the signal path from
the output of an audio track, through an output
bus mapped to an output path that is routed to
a physical output on an HD I/O audio interface:

(1) Track Output Audio is played back from disk
and routed from the Track Output to Output
Bus “B 1-2.”

(2) Output Bus Path The Output Bus is defined
on the Bus page of the I/O Setup. On the Bus
page of the I/O Setup, the Output Bus “B 1-2” is
mapped to Output “B 1-2,” which is defined on
the Output page of the I/O Setup.

(3) Output Path On the Output page of the I/O
Setup, the Grid is used to route the output path
(to which the output bus is mapped) to physical
outputs.

(4) Physical Output For Pro Tools|HD interfaces
such as the HD OMN]I, the physical outputs that
are available to Pro Tools are set on the Main
page of the Hardware Setup (this selector is mir-
rored in the Output page of the I/O Setup).

Q For Pro Tools systems such as the Mbox and
the 003, physical outputs are fixed. For
third-party and built-in hardware, click the
Launch Setup App button in the Hardware
Setup for available configuration options.
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Hardware Setup

Peripherals
HD OMNI #1 Interface: HD OMNI

> HD /O #1

[ Main | Analoeg In

@ Input

 ~ 1-2 [ Analog 1-2 3 |
I 3-4 [ Analog 3-4 3 |
HD Core PCle #1
| 5-6 | AES/EBU 1-2 3]
Clock Source: iy EPE— ':‘]
| Internal ':‘i I

Digital 1-2 Input Format:

Loop Master: HD OMMNI #1 I

| 1/O Setup
[ Input | Output Bus Insert Mic Preamps
! ' A @
| HD OMNT #1
|
Name Folwa»’:ﬁ';u “‘;‘3:9 AE]S.-_'EBU AJB_‘;T
V| Al-2 M serea | [[R |
[ Al————Monu--M‘(2)
| A2 Mono T
> A3-4 W[ Stereo LR
> A5-6 W[ stereo L|r
> A7-8 W[ Stereo L|r

Figure 1. Input signal path from an HD OMNI to the Pro Tools mixer as mapped in /0 Setup
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1/0 Setup. !
[Input = Output | Bus | Insert = Mic Preamps  H/W Insert Delay |
T Name Channels " Wapping to Output
T Stereo Monitor E Stereo L R E Stereo Monitor
> A3-4 ™| Serea L R ™ A3-4
> A5-6 ™| Swereo L R ™ A5-6
B AT-8 ™| Steren Lf'2\ ™ A7-8
> A9-10 M s | \Z/ A9-10
—pp 12— M —er— | — I B1-2
> B3-4 ™| Swereo L R ™ B34
B B5-6 W Serea L R ™ B5-6
> B7-8 ™| Sereo L R B7-8
> 89-10 ™| Serea L R ™ 89-10
> B11-12 ™| Swereo L R £ B11-12
> B13-14 W Serea L R f B13-14
> B15-15 ™| Sereo L R B15-16
> Bus 1-2 | Sereo |L R O
> Bus 3-4 | Sereo |L R =]
| Input | Qutput | Bus Insert Mic Preamps H/W Insert Delay 1
A . B
HD OMNI #1 w HD 1/0 #1
Name Format M;g‘“ A';i_j:u Ag“_jgu A';f';u ?_‘; "';_'é‘"
Monitar /] Monitar | Mon IN
A3-4 Steren L[r
A5-6 Stereo LR +
AT-8 Steren L[r |
4810 Stereo L{r] |l
P B1-2 M oere — | i |
B3-4 Stereo » 3/ L[r
B5-6 Steren L[r
B7-8 Steren L[®
B9-10 Steren L|r
e

Figure 2. Output signal path from an audio track to a physical output as mapped in I/0 Setup
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Session Interchange

When exchanging a session between Pro Tools
systems, you may need to reconfigure the ses-
sion’s I/O settings. This will depend on system
ID, path names and/or path format, as well as on
the Pro Tools versions of each system on which
the session is transferred.

Path Names and Automatic Output
Bus Remapping

A system ID is created and saved in a session for
every computer the session is opened on (using
the computer’s MAC address). If Pro Tools finds
a matching system ID when opening a session,
output paths are restored and no reconfiguring
is necessary.

When a Pro Tools session is opened on a system
for the first time, Pro Tools attempts to automat-
ically remap output busses.

If Pro Tools does not find a matching system ID,
Pro Tools attempts to remap output busses ac-
cording to the following criteria (in order):

Path Name and Format Path names must be ex-
actly the same, and of the same format. Use the
suggested path naming schemes (see “Recom-
mended Output Path Naming Schemes” on
page 30).

Path Format Only If matching path names are
not found, Pro Tools remaps paths to existing
paths of the same format (channel width).

Any output bus path that cannot be automati-
cally remapped is opened as Inactive. You must
manually remap those paths to an active output
path.
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Recommended Output Path Naming
Schemes

Generally, you will want to use standard nam-
ing schemes for output paths in your Pro Tools
sessions. This facilitates session exchange be-
tween different Pro Tools systems.

Here are some examples of standard industry
naming schemes:

e Main A, Main B

e Studio A, Studio B

e Stereo A, Stereo B

o Meter

* Monitor

e Aux A, Aux B

e Cue A, Cue B, Cue C, Cue D, CueE, Cue F,
Cue G, Cue H, Cuel, Cue]

e Dial Main, Dial A, Dial B, Dial C, Dial B,
Dial E

e Efx Main, Efx A, Efx B, Efx C, Efx D, Efx E

e Music Main, Music A, Music B, Music C,
Music D, Music E

Pro Tools Versions and Session
Interchange

When exchanging a session between systems
with different versions of Pro Tools software
(such as your Pro Tools 9.0 system and a col-
league’s Pro Tools 8.x system), use the following
to maintain paths and signal routing.



Pro Tools 8.1 and Higher

When exchanging sessions among systems run-
ning Pro Tools 8.1 or higher, it is generally rec-
ommended that the Sessions Overwrite Current
I/0 Setup When Opened option be disabled. This
maintains any system I/O settings when open-
ing a session from another system (see “Sessions
Overwrite Current I/O Setup When Opened” on
page 22).

Pro Tools 8.0.4 and Lower

When exchanging sessions with systems run-
ning lower versions of Pro Tools, it is generally
recommended that the Sessions Overwrite Cur-
rent I/0 Setup When Opened option be enabled
(see “Sessions Overwrite Current I/O Setup
When Opened” on page 22). In this case, any
custom settings saved with the session that do
not match your system may need to be reconfig-
ured manually in the I/O Setup to match your
current studio setup.

Q If you created a backup of your I/O settings

" by exporting your 1/O settings, you can im-

port settings after opening the session. “Im-
porting 1/O Settings” on page 25.

Opening Older Sessions in Pro Tools 8.1
and Higher

When opening sessions created in Pro Tools
8.0.4 and lower in Pro Tools 8.1 or higher, out-
put paths from the legacy session are re-created
as output buses. If the Sessions Overwrite Current
I/0 Setup When Opened option is enabled, the
output buses are mapped to session output
paths.

Q If your hardware configuration has
" changed, you may need to manually recon-
figure output assignments the 1/0 Setup
Grid.

Path Order and Overlapping Output
Paths

When exchanging sessions between Pro Tools
8.1 or higher and Pro Tools 8.0.4 and lower, out-
put paths and sub-paths are changed as follows,
depending on the order in which they appear in
the I/O Setups.

¢ If a session created in Pro Tools 8.1 or higher
contains overlapping paths with a larger path
created above smaller paths in the I/O Setup, the
smaller paths are converted to sub-paths of the
larger path when the session is opened in

Pro Tools 8.0.4 and lower.

o If a session created in Pro Tools 8.1 or higher
contains overlapping paths where a smaller
path appears above a larger path in the I/O
Setup, the larger path will be made inactive
when the session is opened in Pro Tools 8.0.4
and lower.

Show Last Saved Setup and Show
Current Setup

When a session is opened that contains path
definitions for unavailable I/O interfaces, the
I/O Setup lists those paths in italics.

Clicking the Show Last Saved Setup button dis-
plays the audio interfaces used in the original
session. This temporary display lets you check
the last saved I/O configuration for reference
while configuring the I/O settings for your sys-
tem.

Once a session has been opened with unavail-
able I/O retained, you can then reassign tracks
to available I/O paths.
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chapter 6

Advanced DigiBase Features

Pro Tools 9.0 provides advanced search features
and Catalogs that were previously only available
with Pro Tools HD, Pro Tools LE with DV Tool-
kit 2, or Pro Tools LE with Complete Production
Toolkit.

For more information on DigiBase, see the
Pro Tools Reference Guide.

With Pro Tools 9.0, you can:

e Search on any combination of file meta-
data simultaneously.

e Create and share custom Catalog browsers
(Catalogs) that reference files wherever
they are stored.

e View, search, and import files from Cata-
logs even if they are on offline volumes.

Searching for Multiple Criteria
Simultaneously in DigiBase
Browsers

Use DigiBase to find files by name, modification
date, and kind. With Pro Tools 9.0, you can also
search multiple criteria simultaneously, and
search on any criteria.

To start a search:
1 Open any browser.

2 Click the Search icon to display the Search
pane.

You can also start a search by pressing
Command+F (Mac) or Control+F (Win-
dows).

3 If in the Workspace browser, select volumes or
folders to search.

4 Enter text into the File Name field to search by
name, or enter a date, or select a kind from the
Kind pop-up menu.

5 Choose additional search criteria as needed.
Press Tab to move to the next available search
field, or Shift+Tab to move to the previous.

6 Click the Search button, or press Enter (Win-
dows) or Return (Mac).

Chapter 6: Advanced DigiBase Features

33



Searching begins, indicated by the spinning ar-
rows in the toolbar, and by the Search button
changing to Stop. The Results List (at the bot-
tom of the browser) fills with items that match
the search criteria. Items can be selected and au-
ditioned as they are found.

7 Click the Stop button at any time to stop the
search, and keep the list of files already found (if

any).

For detailed information on DigiBase
search functions, see the Pro Tools
Reference Guide.

Saving Search Results as a
Catalog

To save the results of your search as a Catalog:

1 Choose Edit > Select All, or press Control+A
(Windows) or Command+A (Mac), to select all
items in the Items List.

2 From the Browser menu, choose
Create Catalog.
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Catalogs

While Volume browsers are designed to be an
accurate representation of the file structure on a
given volume, Catalogs are similar to having a
Favorites folder, and serve as a way to collect
and organize frequently used items regardless of
where they are stored.

A Catalog is analogous to a folder full of aliases
or shortcuts. Placing a file in a Catalog does not
create a copy of the file, and does not change
where the file is stored. Rather, it stores a refer-
ence (or alias) to the file so that it can be found
and manipulated without having to search for
its physical location.

Opening a Catalog Browser

Catalogs are displayed in the Workspace
browser.

To open a Catalog browser:

1 Open the Workspace browser.
2 Click the Catalogs Expand/Collapse icon.

3 Do one of the following:

¢ Click the Expand/Collapse icon for the de-
sired Catalog to view its contents in the
Workspace.

—Or —

¢ Double-click the Catalog name to open it
in its own browser window.



Clip Names in Catalogs

Clip Names are the names that appear in the
Timeline and Region List when a file is imported
into a session.

For most files, the Clip name is the same as the
file name. For OMF Files, the Clip Name is the
name that appears in the Avid bin.

Clip names can only be edited in a Catalog. Ed-
iting the Clip name does not affect the actual
file; however, if you add the same file to a new
Catalog, it retains its original Clip Name. When
you drag a file from a Catalog into a session, the
edited Clip Name is what appears in the Time-
line and Region List.

If the Clip Name is longer than 32 characters,
Pro Tools truncates the name automatically
when imported into the session.

Comments and Catalogs

Catalogs provide commands for managing Mac
Finder comments, Database comments, and
Clip Names.

Database Comments in a Catalog are stored in
the Catalog database. Database Comments,
which can be up to 256 characters in length, are
searchable, cross-platform, and editable.

Copy 0S 9 Finder Comment to Database Com-
ments (Mac Only) Copies an item’s OS 9 Finder
comments to its Database comments.

Q OS 9 Finder comments (from the OS 9 Get
Info window) are not supported in OS X Get
Info windows. Use the Copy OS 9 Finder
Comment to Database Comments com-
mand to utilize any OS 9 Finder comments
stored with your media.

Copy 0S X Finder Comment to Database Com-
ments (Mac Only) Copies an item’s OS X Finder
comments to its Database comments.

Copy Database Comments to Clip Names Copies
an item’s Database comments to Clip Name.

Copy File Comments to Clip Names Copies an
item’s File Comments to Clip Name.
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Creating Catalogs

Catalogs can be added to the Workspace as new,
empty Catalogs, or you can select items first and
then save a Catalog of all selected items.

To create a new, empty Catalog:

1 Open the Workspace browser.
2 Choose New Catalog from the browser menu.

3 Enter a unique name and click OK.

To catalog a selection of items:

1 Open any browser (including an existing Cat-
alog).

2 Select the items you want to include in the
new Catalog.

3 Choose Create Catalog from Selection from the

Browser menu.

A new, fully indexed Catalog database of the se-
lected items is created.

Creating Catalogs of Folders

To create a Catalog of an entire folder and all its
contents:

1 Open the Workspace browser, if not already
open.

2 Drag and drop a single folder onto the Catalog
icon in the Workspace browser.

Pro Tools first indexes the folder, then a fully in-
dexed Catalog is created, with the same name as
the dropped folder.
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Renaming a Catalog

Catalogs can be renamed at any time.

To rename a Catalog:

1 Click the Catalog item in the Workspace
browser until its name highlights.

2 Enter a new name for the Catalog.

Modifying Catalogs

To add items to a Catalog, do one of the following:

= Open the Catalog and drop new items from
another browser.

= Click the main Catalogs icon in the Work-

space, to expand your view of all existing Cata-
logs, then drop items onto any Catalog.

To add a folder to a Catalog:
1 Open the Catalog.

2 Choose Create Folder from the Browser menu.

To delete items from a Catalog:

1 Select the items.

2 Press the Delete key, or choose Delete Selected
from the Browser menu. A warning dialog ap-
pears.

3 In the warning dialog, do one of the follow-
ing:
¢ Click Cancel to cancel the delete operation.

¢ Click Delete Files to delete aliases and asso-
ciated files from disk.

e Click Delete Aliases to delete only the
aliases and not the associated files.

This operation cannot be undone.



Consolidating Files with Catalogs

Catalogs are excellent tools for consolidating
files from a variety of sources.

For example, create a Catalog named “Thumps”
and fill it with sound effects from three different
volumes. You can then drag the Catalog from
the Workspace browser to another volume, and
a folder named “Thumps” is created on that vol-
ume. All of the files referenced by the Catalog
are automatically copied to the volume. Folders
and sub-folders, if any, and their contents are
included in the copy.

Updating Catalogs

Since a Catalog database is not linked to any par-
ticular volume, there is a limit to the abilities of
the Update Index command. When Update Data-
base for Selected is selected from the Browser
menu in a Catalog, Pro Tools searches for the
items represented by the aliases in the Catalog
and updates the following information:

Metadata Metadata for all files found online, in-
cluding File comments, are updated.

Database Comments Database Comments are
not updated, because they are unique to each
Catalog and are not part of the file’s metadata.

Relinking Catalog Items

If files are ever missing from a Catalog, use the
Relink window to locate, copy, and relink files.
For more information, see the Pro Tools Reference
Guide.

Deleting Catalogs

To delete a Catalog:

1 Select one or more Catalogs in the Workspace
browser.

2 Press the Delete key, or choose Delete Selected
from the Browser menu. A warning dialog ap-
pears.

3 In the warning dialog, do one of the follow-
ing:
e Click Cancel to cancel the delete operation.

e Click Delete Files to delete aliases and asso-
ciated files from disk.

¢ Click Delete Aliases to delete only the
aliases and not the associated files.

This operation cannot be undone.
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Importing Catalog Items

You can import online and offline items from
Catalogs into the current session.

Importing Online Items from a Catalog

Dragging and dropping audio files to the

Pro Tools Region List and Timeline is identical
to dragging and dropping from Volume
browsers.

For more information on importing files by
dragging and dropping from DigiBase, see
the Pro Tools Reference Guide.

Importing Offline Items from a Catalog

With Catalogs, it is possible to search and im-
port files that are offline. For example, if you
have a music cue that you know you want to
use, but it resides on a CD-ROM or other un-
mounted volume, you can spot the file from a
Catalog to the session Timeline, and it is auto-
matically imported into the session when the
volume is mounted.

The first step is to add files to a Catalog (files
must be online to be added to a Catalog). Once
added to a Catalog, if the items are taken offline
they are listed in italicized text.
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Offline files can be dropped from a Catalog to
the Timeline just like online files. When you
drop the files, a dialog appears asking if you
want to relink the files or skip relinking. Click
Skip All to load all the items as offline files (in the
Timeline, their regions appear in light blue). In
the Project browser, these items are listed in the
Render Sources folder, to ensure that Pro Tools
remembers that these items need to be relinked.

Whenever the volume containing the offline
items is mounted, Pro Tools automatically starts
to import the files, in the background. This is
true even if you have saved the session, quit,
and relaunched Pro Tools.

Once the items are completely imported, they
appear as online items in the Timeline, Region
List, and in the Project browser.

If the offline items match the session sample
rate, bit depth, and file format, no conversion is
necessary. As long as the volume is playable, the
items become playable in the session as soon as
the volume is mounted.

If the volume is unsuitable for playback, you are
informed that some items must be copied to
suitable volumes first.

For more information on Transfer files,
missing files, and relinking, see the
Pro Tools Reference Guide.



Editing Features and Enhancements

Auto-Scrolling Tracks in the
Mix and Edit Windows

Pro Tools 9.0 supports auto-scrolling in the Mix
and Edit windows. This feature was previously
only available with Pro Tools HD. If you are
working with more tracks than can be displayed
at one time in the Mix or Edit windows, you can
select a track in one window and Pro Tools will
automatically scroll to that track in both win-
dows.

To auto-scroll the Mix and Edit windows to show a
track, do one of the following:

= In the Track List, Right-click the track name
and select Scroll Into View.

» In the Track List, Control-click (Mac) the track

name and select Scroll Into View.

The track becomes selected, and the Mix and
Edit windows both scroll to display the selected
track.

Navigating to Tracks Using Track
Position Numbers

With Track Number View enabled, each track is
assigned a number corresponding to its position
in the Mix and Edit Windows. You can scroll di-
rectly to any track by its positional number.

Q When tracks are reordered, Track Position
" Numbers are reassigned to keep them in nu-
merical sequence.

To navigate directly to any track using Track
Position Numbers:

1 Choose Track > Scroll to Track.

Press Command+Option+F (Mac) or Con-
trol+Alt+F (Windows) to Scroll to Track.

Scroll To Track: 1

Cancel £ 0K )

Scroll To Track dialog

2 In the Scroll To Track dialog, enter the Track
Number for the track you want to view.

3 Click OK.
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The track is selected, and the windows scroll as
follows:

e The Edit window tracks scroll to bring the se-
lected track as close to the top as possible.

e The Mix window tracks scroll to bring the se-
lected track as close to the left as possible.

Advanced Beat Detective
Features

Pro Tools 9.0 provides advanced Beat Detective
that were previously only available with

Pro Tools HD, Pro Tools LE with Music Produc-
tion Toolkit 2, or Pro Tools LE with Complete
Production ToolKkit.

For information about other Beat Detective
features, see the Pro Tools Reference Guide.

Separating Multiple Tracks

You can use beat triggers from a single track, or
subset of tracks, to separate a group of tracks.

In the following example, the defined selection
is a drum loop consisting of two bars of 5/4. The
kick, snare, hi-hat, and overhead microphones
are recorded to separate tracks.

Analyzing the loop’s kick drum track, with De-
tection Resolution set to Beats, Beat Detective
places beat triggers at the transients on beats 1
and 4 (see Figure 3).

Figure 3. Kick drum track
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Extending the selection to the snare, hi-hat, and
overhead microphones tracks, and then per-
forming the separation, results in separated re-
gions in each of the drum tracks at the same lo-
cation, based on the beat triggers from the kick
drum track.

Figure 4. Kick drum, snare, hi-hat, and overhead
microphones tracks

The separated regions can then be conformed as
a group.

You can also utilize Collection mode when
working with multiple tracks. Collection mode
lets you analyze and detect triggers on tracks in-
dividually, and if you choose, add only the
unique triggers from the current track to the
overall collection.



Detection (Normal) and Collection
Mode

In some instances, it may be difficult for Beat
Detective to successfully analyze multiple tracks
with the same Detection settings. With Beat De-
tective’s Collection mode, you can collect a set
of beat triggers from different tracks, each with
different Detection settings, and use the collec-
tion of triggers to generate Bar|Beat Markers or
DigiGroove templates, or separate new regions.
Collection mode is the only way to analyze and
create beat triggers on one track, and apply
them to another track.

This method of selectively adding beat triggers
from separate analysis passes on different tracks,
until you get only the triggers you want, is po-
tentially much more effective than manually de-
leting, inserting, or adjusting incorrect or false
triggers.

Drum Tracks and Collection Mode

Suppose you have drum tracks for kick, snare,
hi-hat, and overhead mics. If you analyze a se-
lection across all of the tracks, you may get
many false triggers when you raise the Sensitiv-
ity slider high enough to capture the hi-hat ma-
terial (coming mainly from the tracks for the
overhead mics).

However, if you analyze only the track for the
overhead mics, the resulting beat triggers are
slightly later than the material on the other
tracks (since it will take more time for the sound
to reach the overhead mics). If you then extend

the selection to the other drum tracks and sepa-
rate them, the regions from the kick, snare, and
tom tracks will be cut slightly late (see Figure 5

below).

Figure 5. Overhead mics generate late beat triggers

Using Collection mode, you can analyze each
drum track separately, one at a time, optimizing
the Detection settings for each track until you
get the triggers you want. The triggers for each
track can be added successively to the collec-
tion, or you can choose to collect only the
unique triggers from a track. The collection of
triggers that results can then be used to generate
Bar|Beat Markers or a DigiGroove template, or
separate new regions.

Using Collection Mode

Collection mode is available in Bar|Beat Marker
Generation, Groove Template Extraction, or Re-
gion Separation mode (audio only), and is ac-
cessed by clicking the Collection Mode button
in the Detection section.

Detection:

Add All Current Triggers To Collection

Add Cnly Unique Triggers To Collection
Clear All Triggers From Collection

Beat Detective, Collection mode options
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To use Collection mode:

1 In the Edit window, make an audio selection
on a single track. Make sure the selection’s start
and end points fall cleanly on the beat.

2 In the Beat Detective window, select one of
the following modes:

e Bar|Beat Marker Generation
e Groove Template Extraction

* Region Separation (audio only)

3 Define or capture the selection.

For information on defining a Beat Detec-
tive selection, see the Pro Tools Reference
Guide.

4 Configure the Detection options so the selec-
tion’s peak transients are accurately detected.

For information on generating beat triggers,
see the Pro Tools Reference Guide.

5 Click the Collection Mode button.

6 In the Detection (Collection Mode) section,
click Add to add all the current beat triggers to
the collection.
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7 Click the Normal Mode button and move the
selection to the next track you want to analyze.
Make sure to keep the selection range constant
for each track.

Press Start+P (Windows) or Control+P
(Mac) to move the selection up, or
Start+Semi-colon (Windows) or Con-
trol+Semi-colon (Mac) to move the selection
down.

With Commands Keyboard Focus enabled,
press “P” to move the selection up, or Semi-
colon (;) to move the selection down. Hold
down the Shift key to retain and add to the
current selection. (See the Pro Tools Refer-
ence Guide for information on enabling
Commands Keyboard Focus.)

8 Configure the Detection options so the selec-
tion’s peak transients are accurately detected.

For information on generating beat triggers,
see the Pro Tools Reference Guide.

9 Click the Collection Mode button again.



10 Do one of the following:

¢ In the Detection (Collection Mode) sec-
tion, click Add Unique Triggers to add only
the unique triggers from the track to the col-
lection.

e Click Add All to add all triggers to the col-
lection.

¢ Click Clear All to clear all triggers from the
collection.

Each new set of triggers added to the collection
appears in a different color. If successive triggers
in the collection are located closely together (for
example, because of microphone leakage), Beat
Detective keeps only the earlier triggers (see
Figure 6 on page 43).

11 Repeat steps 7-10 for each additional track
you are analyzing.

The beat triggers stored in the Collection mode
are saved with sessions. Therefore, when a ses-
sion is opened later, the previous collection ma-
terial is still there (until it is cleared).

12 Once the desired beat triggers have been
added to the collection, you can use them to
generate Bar|Beat Markers or a groove template,
or separate regions. However, this must be done
from the Collection Mode section (when the
triggers are displayed in multiple colors).

@ To separate regions across multiple tracks,
"~ make sure to extend the selection to any ad-
ditional tracks before separating.

1. Beat triggers
detected in Kick track
added to collection

2. Unique beat triggers
detected in Snare track
added to collection

3. Unique beat triggers
detected in Hi-hat track
added to collection

4.Collected beat triggers
applied to Overhead
microphones track

Figure 6. Overhead mic track displaying a collection of beat triggers containing unique triggers generated from the

kick, snare, and hi-hat tracks
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chapter 8

Automatic Delay Compensation

Pro Tools 9.0 provides automatic Delay Com-
pensation for managing DSP and host-based de-
lays from plug-in and hardware inserts, and
mixer routing (bussing and sends). Lower ver-
sions of Pro Tools only provided Automatic De-
lay Compensation with Pro Tools HD.

With Delay Compensation enabled, Pro Tools
maintains phase coherent time alignment be-
tween tracks that have plug-ins with differing
DSP and host-based delays, tracks with different
mixing paths, tracks that are split off and recom-
bined within the mixer, and tracks with hard-
ware inserts.

To maintain phase coherent time alignment,
Delay Compensation should always be enabled
during playback and mixing. Delay Compensa-
tion should also be used in most recording situ-
ations.

For detailed information about using Delay
Compensation, see the Pro Tools Reference
Guide (Help > Pro Tools Reference Guide).

Enabling Delay Compensation

To enable Delay Compensation:
= Select Options > Delay Compensation.
When Delay Compensation is enabled, the De-

lay Compensation status indicator in the Edit
Window Toolbar is displayed.

Delay Compensation indicator

The Delay Compensation View for tracks can be
displayed in the Mix Window (see “Delay Com-
pensation View” on page 47).
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Configuring the Delay
Compensation Engine

The amount of Delay Compensation available
for your session is set in the Playback Engine.

Delay Compensation Engine

Pro Tools 9.0 supports Automatic Delay Com-
pensation for all Pro Tools systems. In lower ver-
sions of Pro Tools, only Pro Tools HD provided
Delay Compensation.

Current Engine

| Mbox 2 :}

Settings
H/W Buffer Size: | 1024 Samples | 8]

Host Processors: | 2 Processors :

CPU Usage Limit: | 85 % v

Host Engine: E lgnore Errors During Playback /Record
{may cause clicks and pops)
E Minimize Additional 1/0 Latency

Delay Compensation Engine: | Short =

Short Delay Compensation Engine selected with Mbox 2

The Delay Compensation Engine setting deter-
mines how much DSP resources are dedicated to
Pro Tools Delay Compensation, which manages
DSP and host-based delays in the Pro Tools
mixer.

Within a session, you can choose to enable or
disable Delay Compensation (Options > Delay
Compensation).
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To configure the Delay Compensation Engine:

1 Choose Setup > Playback Engine.

2 From the Delay Compensation Engine pop-up
menu, select Short, Long, or None.

3 Click OK.

Delay Compensation Settings

There are three settings in the Playback Engine
to dedicate processing resources for Delay Com-
pensation:

None Allocates no resources for Delay Compen-
sation.

Short Allocates minimum resources for Delay
Compensation for each channel. This is the
most efficient setting. For sessions with only a
few plug-ins that do not induce too much DSP
and host-based delay, this setting should be suf-
ficient.

Long Allocates maximum resources for Delay
Compensation for each mixer channel. For ses-
sions with a lot of plug-ins resulting in a large
amount of DSP and host-based delay, select this
setting.

Delay Compensation Time Mode

Delay values can be specified in either samples
or milliseconds, as selected with the Delay Com-
pensation Time Mode setting in the Operation
Preferences page.



Delay Compensation Limit

The Delay Compensation limit is displayed in
samples in the Delay Compensation Engine
pop-up menu in the Playback Engine dialog.
This is the maximum amount of Delay Compen-
sation available for the session. This value is dif-
ferent depending on the session sample rate and
which Delay Compensation Engine option is se-
lected.

System Delay

Pro Tools adds the exact amount of delay to
each track necessary to make that particular
track’s delay equal to the total System Delay.
The total system delay is the longest delay re-
ported on a track, plus any additional delay
caused by mixer routing.

The System Delay is shown in the Session Setup
window (Session > Setup). Reference the re-
ported System Delay to monitor whether or not
you are close to exceeding the Delay Compensa-
tion limit.

e
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System Delay.

System Delay
System Delay in Session Setup window

A\ Pro Tools HD accounts for converter delays
when using Automatic Delay Compensa-
tion. However, when using non-HD hard-
ware, System Delay only displays internal
delay and does not take into account any la-
tency incurred by the analog-to-digital
(ADC) or digital-to-analog (DAC) convert-
ers in your audio interface.

Delay Compensation View

The Delay Compensation View displays the to-
tal amount of plug-in (TDM and RTAS) and
hardware insert delay (HD only), if any, on each
track. Delay Compensation View displays the
total amount of delay that Pro Tools applies to
each track. You can also apply an offset for track
delay on a track-by-track basis. The Delay Com-
pensation View can be shown or hidden in the
Mix Window.

S Delay indicator
il.—— User Offset field
Sl Track
Compensation
indicator

Delay Compensation View

Q Delay Compensation view only shows the
~insert delay for each track. To view the com-
plete system delay, including mixer delays,
check the System Delay in the Session Setup
window.

To view Delay Compensation information:

= Select View > Mix Window > Delay Compensa-
tion.

Delay Compensation View
Indicators and Field

Delay (dly) Indicator

The Delay (dly) indicator reports the total plug-
in (TDM and RTAS) and hardware insert delay
on the track.
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The Delay indicator’s report to Pro Tools Delay
Compensation Engine can be bypassed when
Delay Compensation is enabled. This is useful
for manually time-aligning a track when the to-
tal delay on a track exceeds the Delay Compen-
sation limit (for more information, see the

Pro Tools Reference Guide).

The display color indicates reported track delay,
as follows:

Green Indicates that track delay reporting is en-
abled and the track does not exceed the avail-
able amount of Delay Compensation.

Orange Indicates that this is the track reporting
the longest plug-in and hardware insert delay in
the session.

Red Indicates that the amount of plug-in and
hardware insert delay on the track exceeds the
available amount of Delay Compensation (for
more information, see the Pro Tools Reference
Guide).

Gray Track delay report is bypassed.

User Offset (+/-) Field

This field lets you adjust track delays manually
while Delay Compensation is enabled. The User
Offset is added to or subtracted from the
amount of delay applied by Track Compensa-
tion. The User Offset is useful for the following
cases:

e For manually time-aligning a track if a

plug-in is incorrectly reporting its delay.
e For adjusting the timing “feel” of a track.

The color of the values in this field indicate User
Offset status, as follows:

White Indicates that the User Offset is enabled
on the track and the User Offset compensation
value is applied to the track.
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Gray Indicates that the User Offset is disabled on
the track and the User Offset compensation
value is not applied.

To change track delay using the User Offset field:

1 In the Delay Compensation View, click in the
User Offset edit field.

2 To set your delay value (in samples or millisec-
onds depending on your current preferences),
do one of the following:

e Enter a positive number (with or without
the “+” modifier) for a positive delay (later
in time) or negative number (with the “-”
modifier) for a negative delay (earlier in
time).

¢ Drag in the User Offset field to scroll to a
new value. For finer resolution, Control-
drag (Windows) or Command-drag (Mac).

e Press the Up and Down Arrow keys to in-
crease or decrease the numerical values.

3 Press Enter.

To bypass the user delay:

= Start-Control-click (Windows) or Command-
Control-click (Mac) the User Offset field. The
user-defined delay appears grayed out and does
not apply to the track.

Track Compensation (cmp) Indicator

This indicator shows the amount of Delay Com-
pensation Pro Tools applies to each track.

The display color indicates the amount of Delay
Compensation applied, as follows:

Green Track compensation is enabled and the
track does not exceed the Delay Compensation
limit. The amount of Delay Compensation
shown in the indicator is applied to the track.



Blue (Audio Tracks Only) Indicates that Delay
Compensation is force-enabled on the track.
When the track is record-enabled or TrackInput-
enabled, Delay Compensation is not suspended
and remains enabled (see “Overriding Low La-
tency Monitoring During Recording” on

page 49).

Red Indicates that the track delay exceeds the
available amount of Delay Compensation and
no Delay Compensation is applied to the track
(for more information, see the Pro Tools Reference
Guide).

Gray Indicates that Delay Compensation for the
track is bypassed and no delay is applied to the
track.

Low Latency Monitoring
During Recording

When an audio track is armed for recording (re-
cord-enabled), TrackInput-enabled, Destructive-
Punch-enabled, or punched in, the track’s Delay
Compensation is automatically suspended (and
the Track Compensation indicator displays 0).
This reduces monitoring latency on those track
outputs. When the track is played back (with
both record-enable and TrackInput disabled) it
is correctly time-aligned with the other delay-
compensated tracks.

Tracks that are not record-enabled still apply De-
lay Compensation. Pro Tools automatically
compensates for any timing discrepancies be-
tween the recorded material and the delay-com-
pensated mix.

Overriding Low Latency Monitoring During
Recording

You can override Low Latency Monitoring Dur-
ing Recording on record-enabled tracks, but this
may introduce latency in the signal path corre-
sponding to the amount of Delay Compensa-
tion. This latency may be acceptable depending
on the recording source. For example, in certain
“non-performance” workflows, overriding Low
Latency Monitoring During Recording ensures
that delay compensation is applied consistently
regardless of whether a track is record- or punch-
enabled, or whether Pro Tools is recording or
playing back.

Q In certain dubbing workflows you may want
to cascade bus recordings to multiple tracks.
In these cases you should be sure to override
Low Latency Monitoring on the recording
tracks.

To override Low Latency Monitoring During
Recording on specific record tracks:

» Command-Control-click (Mac) or Control-
Start-click (Windows) the Track Compensation
indicator. Delay Compensations is applied to
the track and the Track Compensation indicator
displays in blue.

Command-Control-Shift-click (Mac) or
Control-Start-Shift-click (Windows) the
Track Compensation indicator to override
Low Latency Monitoring for all selected
tracks.

Command-Option-Control-click (Mac) or
Control-Alt-Start-click (Windows) the
Track Compensation indicator to override
Low Latency Monitoring for all tracks.

Chapter 8: Automatic Delay Compensation

49



Delay Compensation on
Auxiliary Inputs

Delay Compensation on Auxiliary Inputs can be
bypassed to let you monitor outside sources
(such as the audio tracks of a slaved video deck)
with minimal latency, while still reporting the
track’s delay.

To bypass an Auxiliary Input’s Delay
Compensation:

» Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator. The reported track delay will be zero,
and will appear grayed out.

Delay Compensation for MIDI

Pro Tools automatically maintains time align-
ment between recorded MIDI events and delay
compensated playback.

When Delay Compensation is enabled, a MIDI
event that is recorded to sound “in time” with
delay-compensated material actually is recorded
late by the length of total delay in effect. To
compensate, MIDI events are shifted back in
time by the total session delay following each
MIDI recording pass. MIDI playback after a re-
cord pass with Delay Compensation enabled ac-
counts for the low latency recording path and
maintains phase coherent time alignment with
MIDI playback.

%

<

When any Instrument or MIDI track is re-
cord enabled, all Instrument and Auxiliary
Input tracks with Instrument plug-in inserts
that are configured to receive MIDI in

Pro Tools are set to low-latency mode. In
this case, the Delay Compensation indica-
tors for those tracks display O.
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Low-Latency Recording with
Virtual MIDI Instruments

When a MIDI or Instrument track that is routing
MIDI data to an instrument plug-in is record-en-
abled, Pro Tools automatically suspends Delay
Compensation through the main outputs of the
audio track, Auxiliary Input, or Instrument track
on which the instrument plug-in is inserted. This
allows for latency-free monitoring of the instru-
ment plug-in during recording.

A Delay Compensation for virtual MIDI in-
struments works only when all MIDI and
audio connections take place inside
Pro Tools. While Pro Tools does not
suspend Delay Compensation when you are
using ReWire to connect software synthesiz-
ers and samplers in other ReWire client ap-
plications (such as Reason), Pro Tools can-
not account for any latency within the
ReWire client itself.

MIDI and Audio Processing Plug-Ins

Some audio processing plug-ins (such as Bruno
and Reso) and many instrument plug-ins let you
process audio while allowing MIDI data to con-
trol processing parameters. When you record
enable a MIDI or Instrument track that is con-
trolling an audio processing plug-in, the track
the plug-in is inserted on will go into low-la-
tency mode, effectively making the processed
audio play early. The steps to prevent this and
keep audio time-aligned depend on the type of
track on which the plug-in resides.

To keep audio time-aligned when recording using a
MIDI controlled plug-in on an audio track:

= Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator for the audio track to apply Delay Com-
pensation.



To keep audio time-aligned when recording using a
MIDI controlled plug-in on an Auxiliary Input:

1 Start-Control-click (Windows) or Command-
Control-click (Mac) the Track Compensation in-
dicator for the Auxiliary Input to bypass Delay
Compensation.

2 Enter the total system delay into the User Off-
set field.

H/W Insert Delay
(Compensation)

Pro Tools 9.0 supports H/W Insert Delay Com-
pensation. This feature was previously only
available with Pro Tools HD. To compensate for
the delay (latency) of any external hardware de-
vices (such as an effects unit) used in your ses-
sion, you can set the amount of Hardware Insert
Delay Compensation (in milliseconds) for each
external device. These times will be used by the
Delay Compensation Engine to time-align input
paths when the hardware insert is in use and De-
lay Compensation is enabled.

1/ Sewp
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Insert offset delay fields

Setting an Insert Delay Offset

To set an insert delay offset:

1 Choose Setup > I/0.

2 Click the H/W Insert Delay tab.

3 Type a value, in milliseconds, in the field cor-
responding with the input where the hardware
insert is connected.

A\ Insert delay offsets only have an effect when
the 1I/O is used for hardware inserts.

Determining Your Hardware’s
Insert Delay

Check the documentation for your external
hardware to see if it identifies the hardware la-
tency, or use the following procedure in

Pro Tools to determine the latency for hardware
inserts.

To determine your hardware’s insert delay:

1 Ensure that Automatic Delay Compensation is
enabled (Options > Delay Compensation).

2 Change your session’s Main Time Scale to
Min:Sec.

3 Create two tracks.

4 Route the tracks as follows: Route the output
of track 1 to the device’s inputs, then route the
input of track 2 to the device’s outputs.

5 Place a short tone (or other sound with a de-
finitive beginning) on track 1.

6 Record enable track 2 and press Record Enable
and Play in the Transport window to play back
the audio in track 1 and record it to track 2.

7 After recording, zoom in and measure the
difference between where the audio starts in
track 1 and track 2. The difference is the value
you would enter as your hardware’s insert delay
offset.
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chapter 9

Time Code and Synchronization Features

Pro Tools 9.0 provides various time code and
synchronization features for working with au-
dio, film, video, or digital video that were previ-
ously only available with Pro Tools HD,

Pro Tools LE with DV Toolkit 2, or Pro Tools LE
with Complete Production Toolkit.

For more information on working in
Pro Tools with time code and synchroniza-
tion, see the Pro Tools Reference Guide.

Timebase Rulers

Pro Tools provides three additional Timebase
rulers to Pro Tools that were previously only
available with Pro Tools HD, Pro Tools LE with
DV Toolkit 2, or Pro Tools LE with Complete
Production Toolkit: Time Code, Time Code 2,
and Feet+Frames. You can also spot audio to
Time Code or Feet+Frames.

For information on other Timebase rulers,
see the Pro Tools Reference Guide.

To add one of these rulers to the Timebase ruler:

= Do one of the following:
e Select View > Rulers > Time Code.
e Select View > Rulers > Time Code 2.
e Select View > Rulers > Feet+Frame.

Time Code Displays the Time Scale in SMPTE
frames. The Time Code Rate and Session Start
time are set from the Session Setup window. The
Time Code Time Scale is absolute based on the
frame rate.

Pro Tools supports the following frame rates:
e 23.976 FPS
e 24 FPS
e 25 FPS
e 29.97 FPS
e 29.97 FPS Drop
e 30 FPS
e 30 FPS Drop

Secondary Time Code Ruler A secondary time
code ruler, labeled Time Code 2, lets you refer-
ence video frame rates in the Timeline that are
different from the session Time Code rate. How-
ever, you cannot Spot to the Time Code 2 ruler
and it cannot be set as the Main Time Scale. The
secondary time code ruler can be set to show
any Pro Tools supported frame rate. The Time
Code 2 ruler can also display the additional fol-
lowing frame rates:

e 50 FPS

e 59.94 FPS

¢ 59.94 FPS Drop
e 60 FPS

¢ 60 FPS Drop
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Feet+Frames Displays the Time Scale in feet and
frames for referencing audio-for-film projects.
The Feet+Frames time display is based on the 35
millimeter film format. The Feet+Frames Time
Scale is absolute based on the frame rate.

Secondary Time Code Ruler

Pro Tools provides an additional time code
ruler, labeled Time Code 2, in the Pro Tools Edit
window. This secondary time code ruler lets you
re-reference video frame rates in the Timeline
that are different from the session time code
rate.

The Time Code 2 ruler can be set to show any of
the following rates:

e 23.976 FPS

e 24 FPS

e 25FPS

e 29.97 FPS

e 29.97 FPS Drop
e 30 FPS

¢ 30 FPS Drop

e S0FPS

e 59.94 FPS

e 59.94 FPS Drop
e 60 FPS

¢ 60 FPS Drop

The Time Code 2 ruler cannot be set to the Main
Ruler in Pro Tools.
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Half-Frame Nudge/Grid

Pro Tools provides an additional grid resolution
of 1/2 Frame to allow for easy alignment of ma-
terial when referencing a high-definition (HD)
frame rate on the secondary time code

(Time Code 2) ruler.

Selecting Time Code and Time
Code 2 Rates

The Time Code Rate and Time Code 2 Rate for
the session can be set in the Session Setup win-
dow with the Time Code Rate and Time Code
Rate 2 selectors. The Time Code ruler displays
the Time Scale in SMPTE frames (hours:min-
utes:seconds:frames).

Pro Tools supports the following rates and for-
mats: 23.976 fps, 24 fps, 25 fps, 29.97 fps Non-
Drop, 29.97 fps Drop, 30 fps Non-Drop, and

30 fps Drop. In addition, Pro Tools supports au-
dio pull up and pull down (see “Pull Up and Pull
Down Commands” on page 56).

See the Pro Tools Reference Guide for
more information on time code and
synchronization.

Selecting Feet+Frame Rate

The Feet+Frame Rate for the session can be set in
the Session Setup window with the Feet+Frame
Rate selector. Supported rates are 23.976, 24,
and 235 fps.

Set this rate to match the rate of the film projec-
tor, or the video if the film projector speed is
taken into account.



Redefining Time Code
Position

Redefining a Time Code Position

Use the Current Time Code Position command to
redefine the current time code position and ses-
sion start time. By creating an insertion point
(or selection), and then entering the new time
code position for that location, the session start
time will be recalculated based on the new, rela-
tive Time Code location.

To redefine a current Time Code code position:

1 With the Selector tool, click in a track (or
make a selection) where you want to redefine
the position.

A\ If your insertion or selection is not on a
grid boundary, it will round to the closest
boundary.

2 Choose Setup > Current Time Code Position.

3 Enter a new SMPTE frame number in the dia-
log to correspond to the time code shown in the
dialog.

4 Click OK.

Displaying Time in SMPTE Frames

In Pro Tools, you can set the Main Time Scale to
Time Code (SMPTE) and this will be displayed in
the Main Counter. Though Pro Tools will still
synchronize to incoming SMPTE time code if
the Time Scale is displayed in Bars|Beats, Min-
utes:Seconds, or Feet.Frames, it is usually more
useful to use SMPTE time code as your reference.

To set the Main Time Scale to SMPTE Time Code,
do one of the following:

= Choose View > Rulers > Time Code.

= Click the Main Counter selector in the Edit
window and select Time Code.

Pro Tools displays time code values in the cur-
rently selected SMPTE frame rate.

Sub Counter and Sub Time Scale
Display

You can display a Sub Time Scale in the Sub
Counter. For example, if the Main Time Scale is
set to Time Code, and you want to compare
SMPTE time to “wall clock,” when you are using
29.97 Non-Drop frame rate, click the Sub Coun-
ter selector and select Min:Secs as the Sub Time
Scale.

Redefining Current
Feet+Frames Position

Use the Current Feet+Frames command to rede-
fine the Feet+Frames position at the current in-
sertion point. The session start time is recalcu-
lated based on the new, relative Feet+Frames
location.

Typically, this command is used for integrating
test tones, pre-roll, Academy leader, and similar
pre-program material into Pro Tools sessions.
Redefining Feet+Frames does not redefine the
session start time.
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To set a relative frame position for a session
(Feet+Frames):

1 With the Selector tool, click in a track (or
make a selection) where you want to redefine
the position.

A\ If your insertion or selection is not on
a grid boundary, it will round to the
closest boundary.

2 Choose Setup > Current Feet+Frames Position.

3 Enter a Feet+Frame position to correspond to
the time code shown in the dialog.

4 Click OK.

Use Subframes Option

When spotting or shifting material in Pro Tools,
or using the Go To dialog, enable the Use Sub-
frames option for greater precision.

Shift
Shift O Earlier By

@ Later
Bars & Beats: —0_|_0-_OE
Minutes & Seconds: E.co0.000
SMPTE: | 00:00:00:00.00 |
Feet + Frames: 0+00.00
Samples: 70_

E Use Subframes

o)

F——TTTT
[ Cancel )
j S

Shift dialog with the Use Subframes option enabled

A subframe is 1/100th of a frame. The Use Sub-
frames option enables you to use these smaller
units for greater accuracy. When enabled, this
command adds a decimal and two decimal
places of additional time for subframes in
SMPTE and Feet+Frames-based fields in the
Spot, Shift, and Go To dialogs.
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Pull Up and Pull Down
Commands

Use Audio Rate Pull Up/Down and Video Rate
Pull Up/Down for audio layback to film or
video, or when recording audio for film or
video. See the Pro Tools Reference Guide for more
information.

A\ When using a video I/O (such as the Avid
Mojo) as the S/PDIF clock source, Audio
Rate Pull Up/Pull Down is not supported.

Audio Rate Pull Up/Down Applies pull up or pull
down factors to session audio record and play-
back. The Audio Rate Pull Up/Down pop-up
menu is located in the Session Setup window.

Video Rate Pull Up/Down Lets you change the
frame rate of video playback independently
from the audio pull-ups (if any). The Video Pull
Up/Down pop-up menu is located below the Au-
dio Rate Pull Up/Down pop-up menu in the Ses-
sion Setup window. Choices are determined by
the file format of the video clip, as well as its
frame rate.



Audio Pull Down Factors and QuickTime Movies

Audio “pulls” are an industry standard method
of adjusting the speed of audio playback to line
up with off-speed picture.

In normal industry standard workflows, when
audio is pulled down, video and time code
maintain their current speed, and only the au-
dio and MIDI are pulled down, in relationship
to the video and time code.

For example, when 24 frame film to 29.97 NTSC
video transfers are made, it is necessary to slow
the film playback speed during the transfer pro-
cess by 0.1%.

In order to make the same speed change for pro-
duction audio to match the speed of this new
slower picture, Pro Tools audio needs to also be
“pulled down” by 0.1%.

To slow audio in Pro Tools, the audio can either
be sample rate converted on import or the in-
coming word clock sample rate source must be
“pulled down” by 0.1% (resulting in a 48,000 Hz
session speed to be pulled down to play in real
time at 47,952 Hz). The pull down setting in
Pro Tools adjusts the visual representation of re-
gions on the timeline to equal the word clock
pull up/down change.

When the clock is reset to the non-pulled down
sample rate, the audio plays at the original film
speed.

Q MIDI is always pulled in line with audio
" pulls.

Pro Tools offers limited pull capabilities, primar-
ily for Pro Tools HD users who have a secondary
Pro Tools system that they use to perform
smaller tasks or for remote work.

Although Pro Tools offers some pull down op-

tions, it does not have the ability to adjust the

internal sample clock the same way

Pro Tools|HD and Pro Tools|HD Native systems
do in tandem with a SYNC peripheral (such as

SYNC HD).

Since Pro Tools does not have any means to ad-
just the Pro Tools sample clock, it instead simu-
lates the audio/video pull relationship by pull-
ing up the video instead of pulling down the
audio. This maintains the proper video/audio
speed relationship when using the fixed

Pro Tools internal clock. The audio sample clock
is not pulled down, so the digital outputs are not
outputting a pulled down sample clock.

If you are using an external clocking source
(such as S/PDIF or ADAT Optical), Pro Tools au-
dio and MIDI are resolved to the digital input’s
clock speed. If you select audio pull down, the
audio still doesn’t pull down in Pro Tools LE;
the video still pulls up to maintain the proper re-
lationship, and the actual Pro Tools sample rate
is now dependent on the digital clock source.
However, if the incoming digital clock speed is
pulled down, Pro Tools audio and MIDI will run
at a pulled down rate, and the video will play
back at its normal speed.

When pull down is selected in Pro Tools, the fol-
lowing occurs:

¢ If the external clock is not pulled down, the
actual sample rate of Pro Tools audio and
MIDI is not pulled down, but the video is
pulled up.

e If the external clock is pulled down, the ac-
tual sample rate of Pro Tools audio and
MIDI is pulled down, and the video plays at
its original non-pulled speed.
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PRE Support

Pro Tools 9.0 provides support for PRE that was
previously only available with Pro Tools HD.

For information about PRE, see the PRE
Guide.

Mic Preamps

In the Peripherals dialog, the Mic Preamps page
lets you configure up to nine different Mic Pre-
amps (PRE) for Pro Tools.

A T A A

) Remene Lock-Dut Mode

Cancel oK

Type

The Type setting lets you select none or PRE. Se-
lect the PRE option to declare any connected
PRE.

Receive From

The Receive From setting lets you specify the
MIDI In port to which the PRE is connected.

Send To

The Send To setting lets you specify the MIDI
Out port to which the PRE is connected.

Defaults

Click the Reset button reset the corresponding
PRE to its default settings.

Retain Current Settings

Select the Retain Current Settings option to retain
PRE channel settings when an existing session
with different settings is loaded. New sessions
will automatically retain the current settings.
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Mic Preamps in 1/0 Setup

On the Mic Preamps page of the I/O Setup, sig-
nal paths for one or more PRE multi-purpose mi-
crophone preamplifiers can be mapped to audio
interfaces. For more information, see the PRE
Guide.

!Input = Output = Bus Insert | MicPreamps | H/W Insert
B
HD 170 #1

1 23 456 7 8 910111213 14 15

[ PRE #1

Mic Preamps
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Mic Preamps in Pro Tools Edit
and Mix Windows

After you create a new track and set the track in-
put to an analog input that the PRE output
channel is mapped to, the PRE controls (identi-
fied as Mic Preamps) appear on top of the track
channel strip. If you do not see these controls,
choose Display > Mix Windows Shows > Mic Pre-
amps View.

To create a track with a Mic Preamp

1 Choose Track > New, and create a mono or ste-
reo audio or Auxiliary Input track.

2 Select an input path from the track Input Se-
lector. Make sure you choose an input that a PRE
output was mapped to in I/O Setup.

If the Mic Preamps view doesn’t appear at the
top of the channel strip, you may need to set the
Mix or Edit window to show PRE controls (see
“Viewing Mic Preamp Controls in Pro Tools” on
page 61).
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Mic Preamp Paths

When audio tracks or Auxiliary Inputs are cre-
ated, their mono, stereo, or multichannel for-
mat is defined. This format determines the Mic
Preamp behavior. Mono tracks control a single
channel, stereo tracks control two channels, and
multichannel tracks control multiple channels.

Using multi-channel input paths

Pro Tools allows you to create multichannel in-
put paths in the Inputs tab of I/O Setups. When
these multichannel inputs use a physical input
which has been mapped to a PRE output, their
controls will become automatically ganged to-
gether when a multichannel track input assign-
ment is made.

This is useful for stereo-pair miking situations
where you may want both microphones to be-
have in a similar manner—for example, gain
and phantom power controls affect both chan-
nels simultaneously.

If you are using advanced miking patterns, such
as M/S pairing, you will not want the micro-
phones to be ganged together. In this example,
you would want phantom power enabled on the
condenser mic, but not on the dynamic mic.
Furthermore, it is unlikely that they would have
the same gain setting. If you need to use multi-
microphone configurations and do not want
their PRE controls to be linked, use individual
mono inputs and mono paths.



Viewing Mic Preamp Controls
in Pro Tools

Source and

Impedance 9 Mic Pre window
Phase HPF

Pad Insert

Phantom Gain

Power

Mic Preamps View, Mix window

Both the Mix and Edit windows can be config-
ured to show or hide PRE controls.

To show or hide Mic Preamp controls in the Mix
and Edit windows:

= Choose View > Mix Window or View > Edit Win-
dow, or click the View Selector in the Edit win-
dow or Mix window, and do one of the
following:

¢ Select Mic Preamps View to show all Mic Pre-
amp controls, or deselect to hide.

e Select All to display the Pro Tools input/out-
put controls, Mic Preamps, inserts, sends,
and comments.

¢ Select None to hide Pro Tools input/output
controls, Mic Preamps, inserts, sends, and
comments.

Mic Preamp Controls

The Mic Preamps view provides all the essential
controls for a PRE channel in the Mix and Edit
windows.

Source and Input Impedance Selector

Clicking the up/down arrows in the Mic Preamp
window accesses two sets of controls. The top
half of this pop-up menu sets the input source
for the PRE channel to Mic, Line, or DI (instru-
ment). The bottom half of this pop-up menu
sets the input impedance for a PRE channel to
1.5 kQ, 15 kQ, or 1.5 MQ.

Mic Preamp Window Button

Clicking the Mic Preamp Window button
(labeled mic, inst, or DI) opens a floating Mic
Preamp window, an alternative to Mix and Edit
window views. See “Mic Preamp Window” on
page 62.

Phase Button
This button applies phase reversal to individual
channels.

High-Pass Filter Button

This button applies a high-pass filter to individ-
ual channels.

Each PRE channel includes a high-pass filter
with a center frequency of 85 Hz and a roll-off of
-18 dB/octave. Use the high-pass filter to re-
move microphone proximity effects, hum, rum-
ble, wind, and other low frequency sounds.
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Pad Button and LED

This button applies an input pad to individual
channels to reduce input sensitivity by 18 dB.

Insert Button

This button enables insert points on individual
channels. PRE’s back panel has eight pairs of
Send and Return jacks for inserting external pro-
cessors (such as compressors or EQs) in the au-
dio path. Inserts are post the output trims.

If you do not have your signal routed through
an external effects unit, enabling the Insert will
effectively mute your signal.

Gain Indicator and Mini Fader

The Gain indicator features a mini fader to ad-
just gain to the input signal on the PRE. The
gain range for each input (Mic, Line, and Instru-
ment) is O dB to +69 dB, adjustable in incre-
ments of approximately 3 dB.

Phantom Power

This button toggles 48V phantom power to Mic
inputs.
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Mic Preamp Window

The Mic Preamp window provides all the essen-
tial PRE controls, plus a gain fader and access to
the channel strip Input Selector, as an alterna-
tive to Mix and Edit window views.

To open a Mic Preamp window:

= Click the Mic Preamp Window button
(labeled mic, line, or DI).

To view a different Mic Preamp window:

= Click the Mic Preamp Windows button
(labeled mic, line, or DI).

To open additional Mic Preamp windows:

= Shift-click the Source button in another Mic
Preamp window.

To set a window to remain open:

= Make sure the Target is deselected (gray, unlit).



Mic Preamp Window Controls

Mic Preamp windows provide standard selectors
for PRE controls and other controls in the top
area of the window.

Input
Source
Phase
Pad

Phantom
Power

Gain

Mic Preamp window standard controls
Standard Controls

Refer to “Mic Preamp Controls” on page 61 fora
description of Mic Preamp view controls that are
mirrored in the Mic Preamp window. The fol-
lowing controls are not available in Mic Pre-
amps view:

Input Selector Allows you to change which
channel you wish to assign this track. Changing

the Mic Preamp channel will also change the in-

put of the track.

Gain Level Fader and Field Mic Preamp gain can
be changed by clicking on the fader and moving
the mouse, or by typing a valid gain value in the
field and clicking Enter. Other values will snap
to the closest permitted value (for example, en-
tering 10 will snap to +9 dB).

Target When the Target icon is red, the next
window opened of the same type replaces the
current display. When unlit, the current win-
dow anchors to its current contents and loca-
tion on-screen. Opening additional windows
does not affect anchored windows.

To set an open Mic Preamp window as the Target
window:

= Click to enable the Target (it is red when en-
abled, gray when disabled).

Adjusting Mic Preamp
Controls

To adjust a control on a single channel:

1 Choose View > Mix Window Views > Mic Pre-
amps.

2 Click the Mic Preamp control that you want to
adjust.

Chapter 10: PRE Support

63



Adjusting Controls on Multiple
PREs

When working with PRE controls on multiple
channels in Pro Tools, you must select tracks
from within Pro Tools. Pro Tools does not regis-
ter selections from the PRE front panel.

To adjust PRE controls on multiple channels:
1 Hold Shift and select the tracks whose PRE

controls you want to adjust.

2 Hold Shift+Option (Mac) or Shift+Alt (Win-
dows) and adjust PRE parameters on any se-
lected track.

Adjustments made to any control on a selected
track are made to the corresponding controls on
all selected tracks.

To adjust controls on all channels:

= Hold Option (Mac) or Alt (Windows) and ad-
just PRE controls on any track.
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Complete Production Toolkit 2

The Complete Production Toolkit 2 software op-

tion for Pro Tools 9.0 provides additional fea-
tures and plug-ins for music creation and post
production.

For detailed information about the Com-
plete Production Toolkit 2 software option,
see the Complete Production Toolkit 2
Guide.

For information on standard Pro Tools fea-
tures, refer to the Pro Tools Reference Guide
(Help > Pro Tools Reference Guide).

Complete Production Toolkit 2
Overview

Complete Production Toolkit 2 enables the fol-
lowing features in Pro Tools:

e Up to 32 channels of I/O depending on your
audio interface

e Surround mixing up to 7.1 (depending on the
output capabilities of your audio interface)

Q Use the Neyrinck SoundCode™" Stereo down
" mixer plug-in for monitoring surround ses-
sions in stereo with audio interfaces that
have fewer than six outputs.

e Up to a total of 192 voiced audio tracks (up to
512 voiceable audio tracks):

e Playback of up to or a combination of play-
ing back and recording up to 192 mono
tracks or 96 stereo tracks (192 available
voices) at 44.1 kHz and 48 kHz

e Playback of up to or a combination of play-
ing back and recording up to 96 mono
tracks or 48 stereo tracks (96 available
voices) at 88.2 kHz and 96 kHz

e Playback of up to or a combination of play-
ing back and recording up to 48 mono
tracks or 24 stereo tracks (48 available
voices) at 176.4 kHz and 192 kHz

Q Pro Tools with Complete Production Toolkit 2
" displays up to 512 tracks, with a simultane-
ous voice limit of 192 tracks. Tracks in excess
of the 192-voice limit are set to inactive.
* Ability to use QuickPunch™ on up to 64 tracks
e Up to 160 Auxiliary Input tracks per session
e Up to 128 Instrument tracks

¢ Advanced Group dialog:
e VCA assignments
e Attributes tab
¢ Follow globals

e Momentary Solo Latch Back/Forward com-
mands

e Custom Shuttle Lock speeds
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e Numeric Keypad set to Shuttle mode
¢ AutoFades

¢ Advanced editing features:
e Continuous Scrolling
e Scrub Trim tool
¢ Replace Region command
e TCE Edit to Timeline Selection command

e Selection of alternate field recorder audio
channels in the Pro Tools Timeline

e Expanding alternate field recorder chan-
nels to new tracks
e Advanced automation features:
e AutoJoin with Latch mode
e Touch/Latch mode
e Trim mode
e Composite automation playlist
e Copy track automation to sends
e AutoMatch

e Prime controls for writing automation in
Latch mode

¢ Glide automation

e Trim automation

e Write automation to Start, End, or All

e Write automation to next breakpoint or
punch point

e Overwrite or extend Mute automation

e Snapshot automation

e Preview automation

e Capture automation

e VCA Master track automation

e Advanced video features:
e Multiple video tracks
e Multiple video playlists
e Video editing
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e Preferences

* Back/Forward Amount

e Shuttle

* Auto Region Fade In/Out Length

e Use Absolute Pan Linking

e Suppress Automation “Write To” Warning

e Allow Latch Prime in Stop

¢ Coalesce when Removing Slaves from VCA
Group

e Standard VCA Logic for Group Attributes

¢ Include Sends in Trim Mode

¢ AutoGlide Time

e Coalesce Trim Automation Options
e D-Control support

e D-Command support

For information about using D-Control and
D-Command worksurfaces with Pro Tools,
refer to the D-Command and D-Controls
Guides, and the Pro Tools Reference Guide.

Additional Software

Complete Production Toolkit includes addi-
tional software for working with Pro Tools:

Neyrinck SoundCode Stereo For monitoring up
to 7.1 surround sessions (down mixed to stereo)
with all Pro Tools interfaces including 2 channel
interfaces (such as the Mbox Mini). This plug-in
also lets you quickly and easily create stereo
mixes from up to 7.1 surround sessions.

X-Form Plug-In For high-quality time compres-
sion and expansion, and formant corrected
pitch-shifting (based on the Radius® algorithm
from iZotope).
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